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Revision Log

The following table identifies changes made to this document since the IBM® FileNet® Workplace 
XT initial release.

Date Revision

07/09 Adds Process Engine REST services information.

Corrects deployment procedures on WebSphere Application Server.

Updates for documentation defects.

12/08 Updates for documentation defects.

11/08 Documentation updates for the IBM FileNet Workplace XT 1.1.3 release.

Removes Installation Planning sections. These topics and tasks have been 
added to the Plan and Prepare your Environment for IBM FileNet P8 guide.

Adds procedures for installing the Content Engine Client file updates. See 
“Install the latest Content Engine Client files on Workplace XT servers” on page 33.

Adds the topic “Install Application Integration BCS for Microsoft Office (Workplace 
XT)” on page 91. 

Expands the upgrade section to include all applicable topics inline.

06/08 Adds the following subtopics to the topic “Review the installation considerations” on 
page 18: 

• “Security considerations” on page 18

• “Accessibility considerations” on page 18

• “Non-English considerations” on page 18

Adds procedure for installing Process Engine Client file updates. See “Install the 
latest Process Engine Client files on Workplace XT servers” on page 36.

Adds procedures for upgrading Workplace XT on JBoss. See “Upgrade IBM 
FileNet Workplace XT” on page 103.
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11/07 Adds upgrade topics “Upgrade IBM FileNet Workplace XT” on page 103 and 
“Upgrade multiple instances of IBM FileNet Workplace XT” on page 123.

Adds JBoss application server topics “Configure IBM FileNet Workplace XT 
(JBoss)” on page 55, “Deploy IBM FileNet Workplace XT (JBoss)” on page 67, and 
“Remove IBM FileNet Workplace XT (JBoss)” on page 129.

Adds procedures for using WebSphere 6.1.x. See “Configure IBM FileNet 
Workplace XT (WebSphere)” on page 39 and “Deploy IBM FileNet Workplace XT 
(WebSphere)” on page 62.

Adds directions for using JAWS screen reader for the setup program in “Install 
IBM FileNet Workplace XT” on page 21.

10/07 Adds information about moving from WAR file to EAR file deployment in 
“Installation Checklists” on page 16 and Task 3 “Install IBM FileNet Workplace XT” on 
page 21.

Moves the "Set permissions for the user running the application server" to 
Task 8a “Deploy IBM FileNet Workplace XT (WebSphere)” on page 62 and Task 8b 
“Deploy IBM FileNet Workplace XT (WebLogic)” on page 65.

Adds accessibility keyboard tip to Task  “Install IBM FileNet Workplace XT 
Application Integration” on page 83.

Corrects a few instances of incorrect references to Workplace instead of 
Workplace XT.

06/07 Initial release of the IBM FileNet Workplace XT Installation Guide.

Date Revision
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About this document

This document provides installation and upgrade information about IBM FileNet Workplace XT.

Topics in this document apply specifically to IBM FileNet Workplace XT installation tasks. 
Information about preparing the FileNet P8 Platform environment before you start these 
installation tasks is in the Plan and Prepare Your Environment for IBM FileNet P8 document. 

To download these documents from the IBM FileNet support Web site, see “Access IBM FileNet 
Documentation, Compatibility Matrices, and Fix Packs” on page 14.

Intended audience
This document is intended for software professionals who install IBM FileNet P8 Platform. IBM 
recommends that an IBM FileNet Certified Professional (FCP) perform the installation. For more 
information about the FCP program, contact your IBM service representative.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Typographical conventions
This document uses the following typographical conventions:

Convention Usage Example

Bold Platform-specific headings Start the application server.

WebSphere

Refer to IBM WebSphere documentation for 
more information.

WebLogic

Refer to BEA WebLogic documentation for 
more information.

Gray bold Clickable items, such buttons, 
and tabs.

Click OK.

Menu paths or breadcrumb 
trails.

Select Start > Settings > Control Panels > 
Display > Screen Saver. 

Italics Variables that require user-
supplied values

The calculation is: number of object stores * 
16 + number of concurrent users.

Document titles You are reading the IBM FileNet P8 Platform 
Installation and Upgrade Guide.

Monospace Text that has to be typed by 
the user 

Copy the file by entering the following 
command:

COPY filename

Code samples Find the following text in the web.xml file:

<context-param><param-name>uploadDir</
param-name><param-value>/opt/FileNet/AE/
Upload1</param-value> </context-param>

Display text, such as prompts 
and error messages

Are you sure you want to delete this 
object?
You do not have permission to delete this 
object.

Elements such as filenames, 
properties, classes and so on, 
whose meaning might get 
confused in regular text. 

Open the filed file.

Enter a value for the new property.

Select the senior class.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Acronyms
This document uses the following IBM FileNet product names and acronyms. 

“Text with 
quotation 
marks”

User-interface fields that do 
not use initial capitalization 
and document headings 
referenced within a document

See the “Part number” field for the part 
number.

For more information, see “Typographical 
conventions” on page 10. 

UPPERCASE Case-sensitive text, where 
uppercase text is required.

Copy the file by entering the following 
command:

COPY filename

Product Name Acronyms

Application Engine AE

Content Engine CE

Content Search Engine CSE

Enterprise Manager EM

Global Configuration Data GCD

Process Engine PE

Convention Usage Example
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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About IBM FileNet documentation
By default, this document is distributed as part of the IBM FileNet P8 help system, but it is also 
available as a downloadable document from the IBM support Web site. Newer versions of IBM 
FileNet P8 documentation are sometimes re-released with other events, such as fix pack releases 
or documentation refreshes. To ensure that you have the latest revision of a document, compare 
the document part number of your document to the document part number of the document that is 
posted on the support Web site: 

www.ibm.com/support/docview.wss?rs=3278&uid=swg27010422

For example, the last two digits of “GC31-5585-05” indicate that the specified document has been 
revised five times after the original publishing, which is designated by 00.

Copy Web documents into the help system and make them searchable 
The IBM FileNet P8 help system is designed so that you can download updated copies of this 
document and copies of other IBM FileNet documents into the IBM FileNet P8 help system and 
index them so that they can be retrieved by a search in the help system. However, to search the 
IBM FileNet P8 help system, it must be installed as a Web site on a Web server that supports 
Java™ applications. 

For more information, see:

• “Other available documentation” on page 14

• “Install the IBM FileNet Workplace XT documentation on the application server” on page 20

Links to additional information
To help you locate additional information about a topic, this document includes links to:

• Other locations in this document

• External Web sites 

• Topics in the FileNet P8 help system

Because this document is included in the default FileNet P8 help system, the links to the FileNet 
P8 help topics work only when you view this document from within the help system. If you view 
this document from outside of the help system, the links to FileNet P8 help topics do not work.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Gather reference documentation
Following are two tables with information about the IBM FileNet P8 documents that are available 
as part of the FileNet P8 release. To download these documents from the IBM FileNet support 
Web site, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14. 

Installation reference documents
Consider having one or more of the following documents (or help topics) nearby for reference 
purposes during the installation of IBM FileNet P8 Platform. 

Document or help topic name... Refer to this document...

Plan and Prepare Your Environment for 
IBM FileNet P8

To confirm the target environment is ready for a 
FileNet P8 installation or upgrade. 

Hardware and Software Requirements To confirm that the target environment has at least 
the minimum supported levels of software from 
independent software providers.

Compatibility Matrix To confirm that the version of FileNet P8 to be 
installed is compatible with at least the minimum 
supported levels of other FileNet products that are 
or will be used with FileNet P8.

Release Notes To familiarize yourself with the new features and 
known issues associated with the FileNet P8 
release.

Installing in Non-English Environment 
Technical Notice

For information about how FileNet P8 supports non-
English environments.

High Availability Technical Notice For information about how to set up FileNet P8 
using clusters, farms and other high-availability 
software and hardware.

Planning and Deployment Guide For information about deploying a FileNet P8 
system from one environment to another. 

Performance Tuning Guide For tuning tips that might affect a FileNet P8 
installation.

Troubleshooting Guide For troubleshooting tips associated with a FileNet 
P8 Installation. 

IBM FileNet P8 help topic: 
Administration > Enterprise-wide 
Administration > FileNet P8 Security > 
Users and Groups

For a complete list of the user and group roles, 
accounts, and responsibilities required to install, 
configure, and maintain a FileNet P8 system.

IBM FileNet P8 help topic: 
Administration > Enterprise-wide 
Administration > Shutdown and Startup

For information about how to shut down and start 
up FileNet P8 and any expansion products. 
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



 About IBM FileNet documentation
Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs

14
Other available documentation
Review the list of remaining FileNet P8 documents that you can download from the FileNet 
support Web site.   

Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs
To access documentation, compatibility matrices, and fix packs for IBM FileNet products: 

1. Navigate to the Product Documentation for FileNet P8 Platform support page.
(http://www.ibm.com/support/docview.wss?rs=3247&uid=swg27010422).

2. Select a PDF or a Doc Link, whichever is appropriate.

Document name Refer to this document...

System Overview For a technical summary of the FileNet P8 
architecture, including a overview of features and 
capabilities.

Planning and Deployment Guide For information about how to move FileNet P8 from 
one environment to another. 

Disaster Recovery Technical Notice For information about potential options and solutions 
involved in a FileNet P8 disaster recovery plan.   

Process Task Manager Advanced 
Usage Technical Notice

For information about properties found under the 
Advanced tab in Process Task Manager.

Version Tools Technical Notice For information about the set of versions tools that are 
installed with FileNet P8 Platform and that identify the 
levels of AE, CE, and PE in a FileNet P8 environment.

Security Help Extract For security-related information from the FileNet P8 
help system in PDF format. 

Rendition Engine Installation and 
Upgrade documents

For information about how to install RE in a FileNet P8 
environment. 
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Customer support
For information about contacting customer support: 

1. Navigate to the FileNet Product Family support page: 
(http://www-01.ibm.com/software/data/content-management/filenet-product-family/support.html). 

2. Click IBM FileNet Support Communications, or search for a particular support topic under 
“Enter search terms”. 

Feedback
Your feedback helps us to provide quality information. Send your comments about this publication 
or any other IBM FileNet documentation by e-mail to comments@us.ibm.com. Be sure to include 
the name of the product, the version number of the product, and the name and part number of the 
book (if applicable). If you are commenting on specific text, include the location of the text (for 
example, a chapter and section title, a table number, a page number, or a help topic title).
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Installation procedures

This installation section contains the following major topics:

• “Installation tasks” on page 17

• “Configuration and startup tasks” on page 70

• “Optional installation tasks” on page 82
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Installation tasks
To install, configure, and deploy IBM FileNet Workplace XT

1. Review the installation considerations for IBM FileNet Workplace XT. Do Task 1 on page 18.

2. Install the IBM FileNet P8 Platform documentation for your application server. Do Task 2 on page 
20.

3. Install IBM FileNet Workplace XT. Do Task 3 on page 21.

4. Install any available IBM FileNet Workplace XT software updates. Do Task 4 on page 32.

5. Install any available Content Engine Client updates. Do Task 5 on page 33.

6. Install any available Process Engine Client updates. Do Task 6 on page 36.

7. Configure IBM FileNet Workplace XT. Do one of the following:

• Task 7a on page 39 (WebSphere)

• Task 7b on page 47 (WebLogic)

• Task 7c on page 55 (JBoss)

8. Deploy IBM FileNet Workplace XT. Do one of the following:

• Task 8a on page 62 (WebSphere)

• Task 8b on page 65 (WebLogic)

• Task 8c on page 67 (JBoss)
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Task 1: Review the installation considerations
This section lists considerations to keep in mind for the installation of IBM FileNet Workplace XT. 
Review this section thoroughly before you start to set up IBM FileNet Workplace XT.

Planning considerations
The planning and preparation tasks required for the installation of IBM FileNet Workplace XT are 
included in the Plan and Prepare your Environment for IBM FileNet P8 guide. To download this 
and other IBM FileNet product documentation from the IBM web site, see “Access IBM FileNet 
Documentation, Compatibility Matrices, and Fix Packs” on page 14.

Security considerations
If you are using Federal Desktop Core Configuration (FDCC) security settings on Vista, and you 
plan to use File Tracker, the security administrator must specify the Workplace XT application 
server as a trusted site in the group policy.

Application server considerations
Workplace XT supports container-managed environments only. Follow the instructions in this 
guide to install Workplace XT in a container-managed environment.

Accessibility considerations
For an accessible install process of IBM FileNet Workplace XT, follow the procedures provided for 
the silent install method, “To install IBM FileNet Workplace XT silently:” on page 22.

Silent installation is also available for Application Integration and File Tracker. See the following 
for details:

• “To install the Application Integration software silently” on page 84

• “To install the File Tracker software silently” on page 89

If you plan to use the JAWS screen reader for the IBM FileNet Workplace XT setup program, see 
the “NOTES” at the beginning of the topic “Install IBM FileNet Workplace XT” on page 21 for 
necessary configuration steps.

In addition, the topic “Install IBM FileNet Workplace XT Application Integration” on page 83 provides a 
Keyboard Tip for alternative navigation in the interface.

Non-English considerations
Releases prior to IBM FileNet Workplace XT 1.1.2.0 required language packs to provide a 
translated user interface. Workplace XT 1.1.3.0 does not require language packs and includes the 
multilingual user interface files, so a separate installation step is not required to install the 
translated version. 
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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For more information about available languages, translated user interface, display settings, and 
functionality related to localized components, see the IBM FileNet P8 Non-English Support Guide. 
To download this and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14.  
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE
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Task 2: Install the IBM FileNet Workplace XT 
documentation on the application server
Before you install IBM FileNet Workplace XT, ensure that at least version 4.0.2-001 of the IBM 
FileNet P8 Platform documentation is installed on your IBM FileNet P8 documentation server. 
Version information is available in the IBM FileNet P8 help topic Help Directory > About the 
documentation - IBM FileNet P8 4.0. Click the Documentation version and build information link for 
details.

To update your IBM FileNet P8 Platform documentation, download the zip file from the IBM 
Information Management support page (www.ibm.com/software/data/support/). For details on locating 
the appropriate files, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 14.

IBM recommends that you copy the PDF of this guide into the ecm_help/installation/
WorkplaceXT install directory on the documentation server before you re-index for the search 
function. That way, the guide is available for future use and is searchable from the IBM FileNet P8 
Documentation online help.

To install Workplace XT documentation 

Because IBM FileNet Workplace XT is an expansion product for IBM FileNet P8 Platform, you must add 
the associated Workplace XT documentation to an existing installation of the IBM FileNet P8 Platform 
Help. This action makes Workplace XT help available to your users and enables context-sensitive help 
from the product user interface. 

For details and instructions on installing expansion product documentation, see the IBM FileNet P8 
Platform Installation and Upgrade Guide. Pay special attention to the Install Expansion Product 
Documentation subtopic in the task Install IBM FileNet P8 Platform Documentation (your application 
server). To download this and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14.

http://www.ibm.com/software/data/support/
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Task 3: Install IBM FileNet Workplace XT
This task includes IBM FileNet Workplace XT installation instructions for all supported application 
servers, for UNIX and Windows platforms. The installer creates the IBM FileNet Workplace XT 
folder structure and files needed for Workplace XT. After installing the files, and any necessary 
updates, you must also configure and deploy the Workplace XT application. These procedures are 
available in subsequent topics.

Before you install IBM FileNet Workplace XT

Read “Review the installation considerations” on page 18, and “Security considerations” on page 18, and 
make sure your installation location meets the requirements specific for IBM FileNet Workplace 
XT outlined in the IBM FileNet P8 Hardware and Software Requirements. To download this and 
other IBM FileNet product documentation from the IBM web site, see “Access IBM FileNet 
Documentation, Compatibility Matrices, and Fix Packs” on page 14.

NOTES

• To ensure proper functionality, performance, and ongoing maintenance, IBM FileNet 
Workplace XT should only be installed once per application server (or virtual machine or AIX 
LPAR). You can, however, deploy multiple instances of a single IBM FileNet Workplace XT 
version per application server.

• If you plan to use JAWS screen reader for the setup program, you must perform the following 
tasks before you begin the Workplace XT install:

a. Ensure that the Sun Java JRE 1.5.0 or 1.5.x is installed on the system where you will be 
performing the install. 

b. Install the Java Access Bridge (available at http://java.sun.com).

c. Start the JAWS screen reader.

• Before logging on to Workplace XT for the first time, make sure at least one object store has 
been created on the Content Engine.

• If you plan to set up a web farm or clustered environment, in addition to these instructions, 
read and follow the instructions in the IBM FileNet P8 Platform High Availability Technical 
Notice. To download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14.

• You must have installed and configured a supported application server for IBM FileNet 
Workplace XT. 

• In the setup program, the version list for application servers includes versions that may no 
longer be supported. To confirm supported versions, check the IBM FileNet P8 Hardware and 
Software Requirements. To download this and other IBM FileNet product documentation from 
the IBM web site, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” 
on page 14.

To install the IBM FileNet Workplace XT software

1. Log in to the application server:
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UNIX

Log in as a user with read, write, and execute access to the directory where you plan to install 
IBM FileNet Workplace XT. 

Windows

Log in as a member of the local Administrators group or a user with equivalent permissions.

2. Start the installation process in one of the following ways, depending on whether you want to run 
in interactive or silent mode:

• To install IBM FileNet Workplace XT interactively:

i. Access the IBM FileNet Workplace XT 1.1.3.0 installation software package. 

i. Launch the appropriate Setup program and follow the prompts, as directed in the 
subsequent steps in this procedure:

ii. Continue with Step 3 on page 23 below.

• To install IBM FileNet Workplace XT silently:

i. Access the IBM FileNet Workplace XT installation software package, and copy the 
XT_silent_install.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the values to reflect the appropriate 
responses for your installation. 

NOTE  Even if you accept all defaults in the XT_silent_install.txt file, you must 
edit the file to accept the license agreement (-V licenseAccepted="true").

iii. From a command prompt, navigate to and run the installer, then continue with Step 4 on 
page 30. 

UNIX

./WorkplaceXT-1.1.3.0-operating_system.bin -options 
“path_to_edited_input_file/XT_silent_install.txt” -silent 

Windows

WorkplaceXT-1.1.3.0-Win.exe -options 
“path_to_edited_input_file\XT_silent_install.txt” -silent

Platform Command

AIX WorkplaceXT-1.1.3.2-AIX.bin

HPUX WorkplaceXT-1.1.3.2-HPUX.bin

HPUXi WorkplaceXT-1.1.3.2-HPUXi.bin

Linux WorkplaceXT-1.1.3.2-LINUX.bin

Solaris WorkplaceXT-1.1.3.2-SOL.bin

Windows WorkplaceXT-1.1.3.2-WIN.exe

zLinux WorkplaceXT-1.1.3.2-ZLINUX.bin
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3. Complete the Workplace XT Installer screens. For information on parameter values, see 
“Installation and upgrade worksheet” on page 17 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the Workplace XT installation program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select WPXT installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, 
and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

Use the parameters from your installation preparation tasks to complete the installer screens, 
as follows:

In the screen for... Perform this action...

Reading the license 
agreement

NOTE  This screen 
appears only when you 
use the installer to 
perform a fresh install.

Review and accept the license agreement.
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Specifying the 
installation path

For the Installation path field, enter or browse to the location 
where you want to install the Workplace XT software 
<install_path>, or accept the default location:

UNIX

/opt/FileNet/WebClient/

Windows

C:\Program Files\FileNet\WebClient\

The installation program installs the Workplace XT software in 
this path.

NOTES 

• The installer will use the <install_path> to place a 
number of other files in default locations. See:

– “Specifying the configuration directory” on page 27

– “Specifying the log file location” on page 28. 

– “Configuring user token security” on page 29

• If you select a custom install path, follow the same directory 
structure as seen in a typical install and retain 
the /FileNet/WebClient part of the path.

Verifying upgrade

NOTE  This screen 
appears only when you 
use the installer to 
perform an upgrade.

The installation program detects supported older versions of 
Workplace XT. 

If the installer reports that no supported version of Workplace 
XT exists on your server or if you don’t want to upgrade your 
Workplace XT at this time, click Cancel to exit the installation 
program. 

Choosing an application 
server

Select the application server and version from the drop-down 
lists. These choices must match your Content Engine 
application server.

In the screen for... Perform this action...
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Configuring Content 
Engine API settings

Configure the Content Engine API settings, as follows:

a. Transport method

Select EJB (Enterprise Java Beans) from the drop down 
list.

b. Content Engine Client software URL:

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server. 

NOTE To verify the correct port to use, navigate to the 
ports section on the application server where Content 
Engine is deployed and check the 
BOOTSTRAP_ADDRESS port.

NOTE To change the Content Engine name later, or to 
connect to a different Content Engine, edit the 
WcmApiConfig.properties file. For information, see 
the IBM FileNet P8 help topic  FileNet P8 Administration > 
Application Engine Administration > Key configuration files 
and logs.

c. Content Engine upload URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number to use when uploading document 
content to the Content Engine server.

d. Content Engine download URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server from 
which to download document content.

In the screen for... Perform this action...
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Choosing deployment file 
type and creation time

Choose to have the wizard create the WAR or EAR file during 
the installation process, or to wait until later.

• Choose Generate a .ear file for deployment if your server 
can deploy a WAR file. Specify an application name for the 
EAR file deployment. The default is WorkplaceXT.

• Choose Generate a .war file for deployment if your server 
can deploy an WAR file. 

• Choose Do not generate a deployment file at this time if you 
have additional installation and configuration to perform 
(such as installing Content Engine and Process Engine 
client files and configuring the application server) that will 
require another generation of the WAR or EAR file.

NOTE If you decide to deploy Workplace XT as a WAR file and 
later decide to redeploy as an EAR file you must uninstall 
Workplace XT and then reinstall the application, selecting EAR 
file deployment.

Specifying the 
documentation URL

Enter the documentation server URL, which is where the IBM 
FileNet P8 Platform Documentation is installed.

Your entry must be in the following format:

http://<docserver:port#>/<ecm_help>/

where: 

docserver is the name of the Java application server.

port# is the port number.

ecm_help is the root folder of the documentation website. You 
can use multi-part root folders (for example, /docs/ecm_help) 
if your application server supports them.

See New Ref To DOC INSTALL for more information. 

NOTE For information on how to reconfigure the documentation 
URL after installation is completed, see the IBM FileNet P8 help 
topic  FileNet P8 Administration > Application Engine Administration 
> Key configuration files and logs >  Bootstrap properties.

In the screen for... Perform this action...
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Specifying the 
configuration directory

Accept the default location or browse to the location where you 
want to store the configuration files.

The default location for the configuration files is in a separate 
Config/WebClient directory one level up from the 
<install_path> directory selected earlier.

Default location of the configuration directory:

UNIX

/opt/FileNet/Config/WebClient/

Windows

C:\Program Files\FileNet\Config\WebClient\

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared location is not supported. You can use an ordinary file 
share.

NOTES 

• If you select a custom install location, follow the same 
directory structure as seen in a typical install and retain the 
/FileNet/Config/WebClient part of the path.  

• The configuration files for an EAR file deployment, a web 
farm, or a clustered environment must be located in a 
shared folder that is accesible by all copies of the 
Workplace application. For more information, see the IBM 
FileNet P8 Platform High Availability Technical Notice. To 
download this guide from the IBM support page, see “Access 
IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs” on page 14.

Specifying the upload 
location

Provide the upload directory path.

The upload directory is the directory used by Workplace XT to 
store temporary copies of files uploaded to Workplace. 

Accept the default option or browse for a directory to hold the 
temporary upload files.

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared upload directory location is not supported. You can 
use an ordinary file share.

In the screen for... Perform this action...
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Specifying the download 
location

Provide the download directory path.

The download directory is the directory used by Workplace XT 
to store temporary copies of  files downloaded from Workplace 
XT. 

Accept the default option or browse for a directory to hold the 
temporary download files.

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared download directory is not supported. You can use an 
ordinary file share.

Specifying the log file 
location

Provide the Log files directory path.

The Log file path is the directory used by the installer to store 
the web_client_install_log_1.1.3.0.txt log file. 

Accept the default option or browse for a directory.

The default location for the log files is in a separate Logs 
directory one level up from the <install_path> directory 
selected earlier.

Default location of the logs directory:

UNIX

/opt/FileNet/Logs/

Windows

C:\Program Files\FileNet\Logs\

NOTE  If you select a custom install location, follow the same 
directory structure as seen in a typical install and retain 
the /FileNet/Logs part of the path.  

In the screen for... Perform this action...
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Configuring user token 
security

Configure user token security.

a. If needed, select the check box to create maximum 
strength keys.

By default the installer creates limited strength keys.

b. Enter the number of keys to use, from 1-100. 

NOTE  Security generally increases with the number of 
keys used.

c. Make a note of the user token crypto key path.

The UTCryptoKeyFile.properties file contains the 
user token cryptography key used by IBM FileNet P8 
applications to launch into each other without the need 
for additional login. 

The default location for the User Token Crypto Key file is 
in a separate Authentication directory one level up 
from the <install_path> directory selected earlier.

Default location of the Authentication directory:

UNIX

/opt/FileNet/Authentication/

Windows

C:\Program Files\FileNet\Authentication\

NOTE  If you select a custom install location it is 
recommended to follow the same directory structure as 
seen in a typical install and retain the /FileNet/
Authentication part of the path.  

CAUTION For multiple applications to pass user tokens to each 
other, each participating application must use the same 
encryption key file. Copy the UTCryptoKeyFile.properties 
file installed with Workplace XT to all servers that are hosting a 
token-sharing application.

For information, see the IBM FileNet P8 Developer Help topic 
Developer Help > Workplace Integration and Customization 
Introduction > User Tokens > Configuring Applications to Use Tokens.

Verifying your installation 
selections

Review the list of selections you have made. You may need to 
scroll to see all selections.

Starting the installation Review the installation summary, and click Install.

In the screen for... Perform this action...
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4. View the web_client_install_log_1.1.3.0.txt file located in install_path/FileNet/
WebClient.

Verify that no errors or failures were logged. Correct any errors before you proceed.

5. (Solaris only) Set the anon ports.

When Solaris first starts up, it takes the first several ports, called anon ports, for its 
communication daemons. By default, the maximum tcp_smallest_anon_port is 32768. IBM 
FileNet uses several ports higher than 32768. See “IBM FileNet Workplace XT port numbers” on 
page 133 for details on which ports IBM FileNet uses.

To use these IBM FileNet ports on Solaris-based systems, you must first enable the ports by 
setting the smallest anon port to 32778. When you do this, the ports used by Solaris 
communication daemons will be 32778 or greater, leaving port 32777 available for IBM FileNet 
use.

The Solaris platform provides several different tools, such as the netstat command, to 
determine if a port is in use.

a. To determine the current tcp_smallest_anon_port setting, enter the following at the 
command prompt:

ndd -get /dev/tcp tcp_smallest_anon_port

If the port is less than 32778, you must enable port 32777.

b. To enable port 32777 on Solaris9, use a text editor to edit the /etc/rc2.d/S69inet file.

Add the following line:

ndd -set /dev/tcp tcp_smallest_anon_port 32778

NOTE  Put this entry in the file before the exit 0 entry at the bottom of the file.

c. To enable port 32777 on Solaris10, use a text editor to edit the /lib/svc/method/net-
init file.

Add the following line:

ndd -set /dev/tcp tcp_smallest_anon_port 32778

NOTE Put this entry in the file before the exit 0 entry at the bottom of the file.

d. Reboot the IBM FileNet Workplace XT server to force the release of ports required by 
Workplace XT that may be in use by the operating system. Failure to reboot after these 
changes are made can result in the port being unavailable, generating OpenSocket errors.

6. (Optional) (UNIX only) Set the the P8TASKMAN_HOME system environment variable.

Completing Workplace 
XT setup

Click Finish to complete the installation.

In the screen for... Perform this action...
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The Process Engine Client installer will set this variable for you. If you want to specify a 
different location for the client files, you can do so by setting the P8TASKMAN_HOME system 
variable. The default value set by the PE Client installer is:

P8TASKMAN_HOME=install_path/FileNet/WebClient/CommonFiles

7. Continue with the task “Install IBM FileNet Workplace XT software updates” on page 32.
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IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE

Task 4: Install IBM FileNet Workplace XT software 
updates
Install any service packs, fix packs, and interim fixes required for Workplace XT.

To install the Workplace XT software updates

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service 
representative or see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 14.

2. Open the readmes for the software updates and perform the installation procedures provided.

3. Install the latest Content Engine and Process Engine client file updates. See Task 5 on page 33 
and Task 6 on page 36.
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Task 5: Install the latest Content Engine Client files on 
Workplace XT servers
Install the Content Engine Client files and any updates that are available.

To install the Content Engine Client files

Refer to the appropriate information from your installation worksheet while performing the following 
steps.

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service 
representative.

2. On the machine where Workplace XT is installed, log on as any user who has the following 
permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Workplace XT is installed.

• Execute permission on the Content Engine Client install software.

3. (For updates only) Verify that there is a current backup of Workplace XT.

4. Copy the Content Engine Client install software from the Content Engine installation software to 
the temporary directory. The version of the install software must match the version of Content 
Engine. 

5. Expand the (TAR or ZIP) Content Engine Client install software within the temporary directory.

6. Close all instances of Workplace XT and any other Application Engine client applications. From 
the application server administrative console, stop and un-deploy Workplace XT.

WebSphere   Stop and un-deploy Workplace XT.

WebLogic   Stop and un-deploy Workplace XT.

JBoss   Run the shutdown command.

7. (WebLogic only) Manually delete the following application server cache directories, substituting 
your domain name  in place of mydomain:

WebLogic UNIX

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/tmp/_WL_user/
web_client

/opt/ bea/user_projects/domains/mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/cache/
EJBCompilerCache

WebLogic Windows

C:\bea\user_projects\domains\mydomain\servers\AdminServer\tmp\_WL_user\web_
client
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C:\bea\user_projects\domains\mydomain\servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\servers\AdminServer\cache\EJBCompiler
Cache

8. Start the Content Engine client install process.

• To install the Content Engine client interactively:

i. Access the IBM FileNet Content Engine client update software.

ii. Run one of the commands in the table below, CE_version is the version of Content Engine 
you intend to run, for example, 4.5.0..

iii. Complete the installation program wizard. 

You can specify on the installer which applications you want to update. If the installer 
does not automatically detect Workplace XT, select it on the appropriate panel. 

You can also choose to have the installer create the deployment file, or create the file 
later. If you have additional configuration to perform, you can defer the file creation to 
avoid running multiple processes to create the same file.

• To install the Content Engine client files silently:

i. Make a backup copy of the input file:

CEClient_silent_install.txt

ii. Open the silent input file in a text editor. Follow the instructions in the silent input file to 
edit the file to reflect the appropriate responses for your update.

iii. Navigate to the path containing the Content Engine Client installation program, and run 
one of the commands in the following table to perform the silent install, where:

CE_version is the version of Content Engine you intend to run, for example, 4.5.0.

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 5: Install the latest Content Engine Client files on Workplace XT servers
To install the Content Engine Client files

35
path is the path that contains the installation program.

Continue with “Install the latest Process Engine Client files on Workplace XT servers” on page 36.

Operating 
System

Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/  
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/ 
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\ 
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/
CEClient.zLinux/CEClient_silent_install.txt -i silent
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Task 6: Install the latest Process Engine Client files on 
Workplace XT servers
Most steps apply to both new installations and updates. However, some noted steps apply only to 
updates of the Process Engine Client files to a previously configured Workplace XT installation.

Install any Process Engine Client files or updates that are available. These steps apply to 
WebSphere, WebLogic, and JBoss (except where noted). Perform the following steps on all 
Workplace XT servers.

To install the Process Engine Client files

1. To download the latest software updates, and to determine which of these updates might be 
required for use with other components and expansion products, contact your service 
representative.

2. Log on to the server as a user who has permission to install software and read and write 
permission to a local temp directory. 

3. (Update installations only) Ensure that there is a backup of the deployed web application 
directory.

4. Download and expand the appropriate tar or zip file for Process Engine Client installation to the 
server and extract the contents to the local temp directory.

5. From Process Task Manager, stop the Component Manager(s) (if running), then exit the Process 
Task Manager application. 

6. (Update installations only) If you wish to retain your existing configurations, copy the following 
configuration files from the backup copy of your deployed application to the /WEB-INF folder in 
the installed directory on your application server, overwriting the existing installed files.

The backup of these files is to ensure the files are still available in case there is any reason to 
go back to the previous versions. When redeploying after installing the fix pack, any custom 
settings will be added back to the deployed working directory.

From the /WEB-INF folder in the backed-up Workplace XT directory created in Step 3 on page 
36 above, copy these files:

WcmApiConfig.properties

web.xml

to here

<XT_install_path>/WorkplaceXT/WEB-INF/ 

NOTE  You must do this before you apply the fix pack to the existing installation.

7. (Update installations only) (WebSphere and WebLogic Only) Stop and undeploy any instances 
of Workplace XT. 

8. (Update installations only) (JBoss Only) Run the shutdown command.
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9. (Update installations only) Manually delete the web application temporary directories associated 
with Workplace XT.

10. (Update installations only) (JBoss only) Delete the deployed Web application directory, or WAR 
or EAR file.

11. Start the Process Engine Client install process.

– To install the Process Engine Client interactively:

i. Access the IBM FileNet Process Engine Client update software.

Launch the appropriate install program, as shown in the following table:

ii. Complete the installer panels and run the installation.

You can specify on the installer which applications you want to update. If the installer 
does not automatically detect Workplace XT, select it on the appropriate panel. 

If you plan to use the ECM Widgets component, or want to use Process Engine REST 
services directly, select Add the REST service on that panel.

You can also choose whether to have the installer create the deployment file for you. If 
you have additional configuration to perform, you can defer the file creation to avoid 
running multiple processes to create the same file.

– To install the Process Engine Client silently:

i. Access the IBM FileNet Process Engine Client update software package, and copy the 
PEClient_silent_input.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the file to reflect the appropriate 
responses for your update. 

Change the Variable_CheckboxXT line to the following:

-V Variable_CheckboxXT="true"

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN

Linux P8PE-CLIENT-4.5.0-LINUX.BIN

Solaris P8PE-CLIENT-4.5.0-SOL.BIN

Windows P8PE-CLIENT-4.5.0-WIN.EXE

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN
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iii. Run the PE Client installer with one of the following commands::

Configure Workplace XT. See the appropriate task according to your application server type:

• “Configure IBM FileNet Workplace XT (WebSphere)” on page 39

• “Configure IBM FileNet Workplace XT (WebLogic)” on page 47

• “Configure IBM FileNet Workplace XT (JBoss)” on page 55

Operating 
System

Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN -options 
"PEClient_silent_install.txt" -silent

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN -options 
"PEClient_silent_install.txt" -silent

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN -options 
"PEClient_silent_install.txt" -silent

Linux P8PE-CLIENT-4.5.0-LINUX.BIN -options 
"PEClient_silent_install.txt" -silent

Solaris P8PE-CLIENT-4.5.0-SOL.BIN -options 
"PEClient_silent_install.txt" -silent

Windows P8PE-CLIENT-4.5.0-WIN.EXE -options 
"PEClient_silent_install.txt" -silent

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN -options 
"PEClient_silent_install.txt" -silent
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Task 7a: Configure IBM FileNet Workplace XT 
(WebSphere)
This topic covers the configuration of your IBM FileNet Workplace XT application on WebSphere.

NOTE  IBM FileNet Workplace XT uses cookie names for passing session information between 
Workplace XT and the client browser. This session information affects how Workplace XT interacts with 
several applets, such as Process Designer, Search Designer, and Process Simulator. To avoid forcing end 
users to log in individually to each applet, do not configure the application server to use application-unique 
cookie names for the deployed Workplace XT. For best results, use JSESSIONID for the cookie name.

To configure IBM FileNet Workplace XT on WebSphere

Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step.

1. If you are using Single Sign On (SSO), edit web.xml. See “(optional) To edit web.xml for SSO” on 
page 39.

2. If you plan to use Application Integration or another option that requires user tokens, configure 
WebSphere to support it. See “(optional) To configure WebSphere to support user tokens for 
Workplace XT (including Application Integration, eForms, Records Manager, and others)” on page 41.

3. Configure IBM FileNet Workplace XT. See “To configure Workplace XT” on page 43.

4. Configure the server ports. See “To configure the server ports (optional)” on page 45.

(optional) To edit web.xml for SSO 

NOTE  SSO in an IBM Tivoli Access Manager environment may require additional configuration in 
WebSphere. If you are implementing SSO in an IBM Tivoli Access Manager (TAM) WebSEAL 6.0 
environment, the junction you use for Workplace XT must be a transparent junction. For more 
details, see your IBM product documentation.

1. Make a backup copy of web.xml.

install_path/FileNet/WebClient//WorkplaceXT/WEB-INF/web.xml

2. Open web.xml for editing.

3. Ensure that the parameter challengeProxyEnabled is set to false, as in:

<init-param>
                <!--
                     Set this parameter to false if deployment is on WebSphere 6, and 
see the commented out
                     sections at the bottom of this file for additional configuration 
adjustments.
                -->
  <param-name>challengeProxyEnabled</param-name> 
  <param-value>false</param-value> 
</init-param>

4. Set the parameter perimeterChallengeMode to true, as in:

 <init-param>
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    <param-name>perimeterChallengeMode</param-name>
    <param-value>true</param-value>
  </init-param>

5. Add the following security role element just after the security-constraint section:

</security-constraint>
- <!--  add login-config element 
  --> 

<security-role>
<description>everyone</description>
<role-name>everyone</role-name>

</security-role>

6. At the end of web.xml, comment out the <login-config> element, as follows:

<!--
<login-config>

<auth-method>FORM</auth-method>
<realm-name>AE Workplace</realm-name>
<form-login-config>

<form-login-page>/ContainerLogin.jsp</form-login-page>
<form-error-page>/ContainerError.jsp</form-error-page>

</form-login-config>
</login-config>
-->

7. Add the following entry: 

<login-config>
<auth-method>CLIENT-CERT</auth-method>

</login-config>

8. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and ssoProxySSLPort 
parameters. These parameter values are used to modify one or more elements of the native 
URL that Workplace XT sees on a request. Wherever the value of an SSO proxy host element 
in the URL request is different from the equivalent information for the host where Workplace 
XT is deployed, then you must set the corresponding sso* parameter for that element in the 
URL to the value for the SSO proxy host in your environment. 

The default settings are:

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters above must be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. This is the 
path portion of the URL that appears after the server name, and which represents top-level access 
to the Workplace XT application. For example, if the IBM FileNet Workplace XT deploy host URL is 
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http://deploy_server:2809/WorkplaceXT and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/WorkplaceXT, then use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value>WorkplaceXT</param-value>

For SiteMinder only, use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this will be a full 
domain-qualified hostname. For example, if the host URL where Workplace XT is deployed is 
http://deploy_server/WorkplaceXT and the corresponding SSO proxy host URL is 
http://sso_proxy_server/WorkplaceXT, then use the following:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. For example:

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined and/or used to 
access Workplace XT pages. For example:

<param-name>ssoProxySSLPort</param-name>
ram-value>443</param-value>

9. Save your changes to web.xml and close the file.

(optional) To configure WebSphere  to support user tokens for Workplace XT (including Application 
Integration, eForms, Records Manager, and others)

The configuration steps that follow enable the generation and acceptance of user tokens on the 
server. Verify these settings in the Bootstrap Settings in the Site Preferences.

1. Stop WebSphere, if it is running.

2. (For installations with Content Engine at 4.5.x) Copy the authentication-websphere.jar 
file from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

WAS_home/AppServer/lib/ext

3. (For installations with Content Engine at 4.0.x) Copy the authentication-websphere.jar 
file from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles/1.1.2

to here:

WAS_home/AppServer/lib/ext

4. Copy the log4j-1.2.13.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/WEB-INF/lib
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to here:

WAS_home/AppServer/lib/ext

5. Enable JAAS.

a. In the WebSphere administrative console, navigate to the Java Virtual Machine > Generic 
JVM Arguments.

b. If there is an entry, add a space after it, then add the following entry and apply your 
changes. (If there is no entry, do not add the space.)

NOTE  Your path may be slightly different depending on the version of your client 
installations, or whether you have chosen a custom path for installation. For example, if 
your Content Engine Client is at 4.0.x, this path may include a samples directory under the 
config directory. Verify the location of the file before you enter the path.

CAUTION  Do not copy and paste the text from this guide because hidden formatting can 
cause problems with the entry. Instead, type the entry into the field. 

CAUTION  (Windows only) On WebSphere for Windows the path cannot contain a space. 
You must use 8.3-notation for the install path information.

If install_path is:

C:\Program Files\FileNet\WebClient

use: 

C:\Progra~1\FileNet\WebClient

UNIX

-Djava.security.auth.login.config=install_path/CE_API/config/
jaas.conf.WebSphere

Windows

-Djava.security.auth.login.config=install_path\CE_API\config\ 
jaas.conf.WebSphere

where install_path is the install path of IBM FileNet Workplace XT.

c. (For components not using SSO only) Create a custom module.

NOTE  Do not perform Step i through Step iv if you are enabling JAAS for any component 
using SSO. Creating the custom module makes SSO unusable.

i. In the Security area of the administration console, navigate to the JAAS login modules.

ii. Click New to create a new custom login module.

iii. Enter the following for the Module class name setting:

com.filenet.ae.authentication.loginmodule.UserTokenWSLoginModule

iv. Apply and save your changes to the master configuration.

6. Enable trust association and specify the interceptor setting.
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a. In the Security area of the administration console, navigate to the Trust association setting, 
and set Enable trust association.

b. Under Additional Properties, click Interceptors.

c. Add a new Interceptor, and and enter the following for the Interceptor class name:

com.filenet.ae.authentication.tai.UserTokenInterceptor

d. Apply and save your changes to the master configuration.

7. Restart WebSphere.

To configure Workplace XT

1. Open the WebSphere administrative console.

2. Set JVM settings for memory.

a. Navigate to Java Virtual Machine.

b. Enter the numbers for the Initial and Maximum Heap Size.

NOTE  Refer to your application server vendor's recommendation for Initial and Maximum 
heap size values. For more information on performance tuning, see the IBM FileNet P8 
Platform Performance Tuning Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 14.

c. Save your changes.

3. Enable Application Integration installation.

a. In the administrative console Environment are, in the Virtual Hosts area, navigate to the 
default_host (or the host your application is deployed under).

b. Add a new MIME Type, application/octet-stream, with .exe for the Extension. 

c. Save your changes.

4. Configure Lightweight Third Party Authentication (LTPA).

NOTE  If you already have Application Engine or Workplace XT in your environment, skip the 
following step (Step a) and continue to Step 5 on page 44.

a. On the Content Engine WebSphere server, do the following:

i. Log in to the administrative console.

ii. If LTPA is not already configured for Content Engine, create an LTPA password, specify 
the location for the Key file on the Content Engine server, and export and import the 
keys.

NOTE  For password restrictions and detailed instructions on configuring LTPA and 
security, see the WebSphere documentation. If you have already configured Content 
Engine for LTPA, use the existing password in the Workplace XT configuration below.
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NOTE  If you already have Application Engine or Workplace XT installed and configured on the 
current application server, skip the following step (Step b), and continue with Step 5 on page 44.

b. On the IBM FileNet Workplace XT server, do the following:

i. Copy the key file from the location you specified above to the IBM FileNet Workplace XT 
server. For example, /opt/LTPA/ltpa_key_name.

ii. Log in to the WebSphere administrative console.

iii. Create an LTPA password, using the same password as the Content Engine.

iv. Set the timeout value for LTPA authentication to a value that is larger than the default. 

For example, if the timeout value is set to 2 hours, the LTPA key expires and end users 
will not be able to log in to Workplace after having been logged in for 2 hours.

v. Specify the path for the key file that you copied to the IBM FileNet Workplace XT server. 
For example, /opt/LTPA/ltpa_key_name.

vi. Import the keys from the key file.

vii. Save your changes to the master configuration.

5. Configure Lightweight Directory Access Protocol (LDAP).

a. Navigate to Security > Secure administration, applications, and infrastructure.

b. Disable security using the following Security settings:

– Turn off (clear) Enable Administrative Security flag.

– Turn off (clear) Enable application security flag.

– Turn off (clear) Java 2 Security.

c. Save your changes to the master configuration.

d. Under User account repository, click Configure.

e. From the bottom of the panel, in the box titled "available realm definitions," select 
Standalone LDAP registry and click Configure.

f. Configure the LDAP provider to exactly match the corresponding settings on the Content 
Engine application server.

– Primary administrative user name

– Select “Automatically generated server identity."

– Type

– Host

– Port

– Base distinguished name (DN)

– Bind distinguished name (DN)

– Bind password
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g. Configure the Advanced Lightweight Directory Access Protocol (LDAP) user registry 
settings to exactly match the corresponding settings from the Content Engine application 
server. 

– User filter

– Group Filter

– User ID map

– Group member ID map

– Certificate map mode

– Certificate filter

h. Save these settings.

i. Next to "Available realm definitions," make sure "Standalone LDAP registry" is still selected, 
and click Set as current. Save this change.

j. Re-enable the following Security settings:

– Turn on (check) Enable Administrative Security flag.

– Turn on (check) Enable application security flag.

– Turn off (clear) Java 2 Security.

NOTE  The IBM FileNet P8 Platform uses LDAP-based security, and does not support Java 
2 security. Enabling Java 2 security can cause unexpected behavior.

k. Save your changes to the master configuration.

l. Test the connection on the Standalone LDAP registry page.  If the test fails, correct the error 
before proceeding.  If it passes, click OK to return to the previous page.

NOTE  If you see a message about the ID not existing in the user repository, ignore it.

6. Set permissions for the user running the application server.

If the user who will be running the application server is different from the user that installed 
IBM FileNet Workplace XT, you must give the user read/write permissions on the following 
folder:

install_path/FileNet/WebClient

7. Stop and restart the application server. 

8. Continue with “To configure the server ports (optional)” on page 45, or continue with “Deploy IBM 
FileNet Workplace XT (WebSphere)” on page 62.

To configure the server ports (optional)

The following procedure applies if you want your LISTENER ADDRESSES to be static.

1. Stop WebSphere, if it is running.
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2. Make a backup copy of serverindex.xml located in:

WAS_HOME/profiles/default/config/cells/machine_nameNode01Cell/nodes/
machine_nameNode01/serverindex.xml

3. Edit serverindex.xml.

4. Locate the <specialEndpoints> section, and change the port numbers for the three SSL listener 
addresses to “0” as shown below:

<specialEndpoints xmi:id="NamedEndPoint_1155689929072" 
endPointName="SAS_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929072" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929073" 
endPointName="CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929073" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929074" 
endPointName="CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929074" host="host_name" port="0"/>
</specialEndpoints>

5. Save and close the serverindex.xml file.

6. Restart WebSphere.

Deploy the Workplace XT application. See “Deploy IBM FileNet Workplace XT (WebSphere)” on 
page 62.
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Task 7b: Configure IBM FileNet Workplace XT 
(WebLogic)
This topic covers the configuration of your IBM FileNet Workplace XT application on WebLogic.

NOTE  Workplace XT uses cookie names for passing session information between Workplace XT and the 
client browser. This session information affects how Workplace XT interacts with several applets, such as 
Process Designer, Search Designer, and Process Simulator. To avoid forcing end users to log in 
individually to each applet, do not configure the application server to use application-unique cookie names 
for the deployed Workplace XT. For best results, use JSESSIONID for the cookie name.

To configure IBM FileNet Workplace XT

Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step.

1. (Optional) If you are using SSO, edit web.xml. See “To edit web.xml for SSO (optional)” on 
page 47.

2. Modify the application server startup script. See “To modify the application server startup script” on 
page 50.

3. Configure IBM FileNet Workplace XT. See “To configure IBM FileNet Workplace XT” on page 52.

4. (Optional) If you are using Application Integration or another optional product that require user 
tokens, configure WebLogic to support it. See “(optional) To configure WebLogic to support user 
tokens for Workplace XT (including Application Integration, eForms, Records Manager, and others)” on 
page 53.

To edit web.xml for SSO (optional)

NOTE  If you are implementing SSO in an IBM Tivoli Access Manager WebSEAL 6.0 environment, 
the junction you use for Workplace XT must be a transparent junction. For more details, see your 
IBM product documentation.

1. Make a backup copy of web.xml.

install_path/FileNet/WebClient/WorkplaceXT/WEB-INF/web.xml

2. Edit web.xml.

3. Set the parameter perimeterChallengeMode to true, as in:

<init-param>

<param-name>perimeterChallengeMode</param-name>

<param-value>true</param-value>

</init-param>

4. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and 
ssoProxySSLPort. These parameter values are used to modify one or more elements of the 
native URL that Workplace XT sees on a request. Wherever the value of an SSO proxy host 
element in the URL request is different from the equivalent information for the host where 
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Workplace XT is deployed, then you must set the corresponding sso* parameter for that 
element in the URL to the value for the SSO proxy host. 

The default settings are:

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters above should be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. This is the 
path portion of the URL that appears after the server name, and which represents top-level access 
to the Workplace XT application. For example, if the IBM FileNet Workplace XT deploy host URL is 
http://deploy_server:7001/WorkplaceXT and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/WorkplaceXT, then use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value>/WorkplaceXT</param-value>

For SiteMinder only, use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this will be a full 
domain-qualified hostname. For example, if the host URL where IBM FileNet Workplace XT is 
deployed is 
http://deploy_server/WorkplaceXT and the corresponding SSO proxy host URL is 
http://sso_proxy_server/WorkplaceXT, then use the following:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. For example:

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined and/or used to 
access IBM FileNet Workplace XT pages. For example:

<param-name>ssoProxySSLPort</param-name>
ram-value>443</param-value>

5. (For SSO with Kerberos only) In the exclude list of the AE PreprocessorFilter section, remove 
the following entries:

/integrationCommand*
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/transport* 

/bootstraptransport

as shown in bold, below.

<filter>
<filter-name>AE PreprocessorFilter</filter-name>
<filter-class>
com.filenet.ae.toolkit.server.servlet.filter.PreprocessorFilter
</filter-class>
<init-param>

<param-name>challenge</param-name>
<param-value>false</param-value>

</init-param>
<init-param>

<param-name>exclude</param-name>
<param-value>

/css/*,
/download/*,
/FnJavaV1Files/*,
/images/*,
/js/*,
/scripts/*,
/Samples*,
/Source*,
/UI-INF/*,
/integrationCommand*,
/integrationResponse*,
/transport*,
/ContainerError.jsp,
/ContainerLogin.jsp,
/ContainerSignout.jsp,
/ServerErrorDisplay.jsp,
/containerSecured/*,
/WcmError.jsp,
/WcmSignIn.jsp,
/GetUserToken.jsp,
/GetTokenSignIn.jsp,
/GetUserInformation.jsp,
/axis,
/axis/services/*,
/servlet/AdminServlet,
/setCredentials,
/SOAPMonitor,
/webdav*,
/P8BPMWSBroker/*,
*j_security_check*,
/bootstraptransport,
/pingSession,
/unitTests*,
/NoContent.jsf,
/ServerErrorDisplay.jsf,
/LoadJSResources.jsf,
/SessionError.jsf

</param-value>
</init-param>

</filter>

6. (For SSO with Kerberos only) Add the following URL patterns:

<url-pattern>/integrationCommand</url-pattern>
<url-pattern>/transport</url-pattern>
<url-pattern>/bootstraptransport</url-pattern>
<url-pattern>/getContent</url-pattern>
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to the security-constraint section, as shown in bold below:

<security-constraint>
<web-resource-collection>

<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/containerSecured/*</url-pattern>
<url-pattern>/integrationCommand</url-pattern>
<url-pattern>/transport</url-pattern>
<url-pattern>/bootstraptransport</url-pattern>
<url-pattern>/getContent</url-pattern>

</web-resource-collection>
<auth-constraint>

<role-name>*</role-name>
</auth-constraint>
<user-data-constraint>

<description>User data constraints</description>
<transport-guarantee>NONE</transport-guarantee>

</user-data-constraint>
</security-constraint>

7. Save your changes to web.xml and close the file.

To modify the application server startup script

1. Stop WebLogic, if it is running.

2. Make a backup copy of the application server startup script.

• If you are using a WebLogic domain, modify startWebLogic.cmd for Windows or 
startWebLogic.sh for UNIX.

•  If you are not using a WebLogic domain, modify startWLS.cmd for Windows or startWLS.sh 
for UNIX. 

3. Use a text editor to open and edit the application server startup script. 

a. Do one of the following to edit the MEM_ARGS variable:

• For all systems except those using JRockit JAVA:

Find the MEM_ARGS variable and append the following to any existing settings:

–XX:MaxPermSize=sizem

where size is the value, in MB, of the MaxPermSize. Refer to your application server 
vendor's recommendation for a value for your configuration. For more information on 
performance tuning, see the IBM FileNet P8 Platform Performance Tuning Guide. To 
download this and other IBM FileNet product documentation from the IBM web site, 
see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14.

• For  systems using JRockit JAVA:

Find the MEM_ARGS variable and append the following to any existing settings:

–Xgc:gencon

NOTE  If the MEM_ARGS variable doesn't exist, add it to the startup script.

b. Configure JAAS login. Add one of the following right after the classpath entry for WebLogic.  
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 7b: Configure IBM FileNet Workplace XT (WebLogic)
To modify the application server startup script

51
CAUTION  Enter the jaas_login entry (bold below) as a single line without line breaks. Do 
not copy and paste the text from this guide because hidden formatting can cause problems 
with the entry. Instead, type the entry into the script. 

NOTE  Your path may be slightly different depending on the version of your client 
installations, or whether you have chosen a custom path for installation. For example, if 
your Content Engine Client is at 4.0.x, this path may include a samples directory under the 
config directory. Verify the location of the file before you enter the path.

AIX

# Jaas Login configuration setting
jaas_login=”${jaas_login}” -Djava.security.auth.login.config=
”install_path/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”
jaas_login="${jaas_login}” -
Dlogin.configuration.provider=com.ibm.security.auth.login.ConfigFile

where install_path is the location where you installed Workplace XT. For example, 
"/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”

UNIX

# Jaas Login configuration setting
jaas_login=”${jaas_login}” -Djava.security.auth.login.config=
”install_path/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”

where install_path is the location where you installed Workplace XT. For example, 
"/opt/FileNet/WebClient/CE_API/config/jaas.conf.WebLogic”

Windows

@REM Jaas Login configuration setting
set jaas_login=%jaas_login% -Djava.security.auth.login.config=
”install_path\FileNet\WebClient\CE_API\config\jaas.conf.WebLogic”

where install_path is the location where you installed Workplace XT. For example, 
"C:\Program Files\FileNet\WebClient\CE_API\config\jaas.conf.weblogic".

c. Add %jaas_login% section as indicated in the examples below in bold.

UNIX - in the WLS_REDIRECT_LOG settings

${JAVA_HOME}/bin/java ${JAVA_VM} -version

if [ "${WLS_REDIRECT_LOG}" = "" ] ; then
        echo "Starting WLS with line:"
        echo "${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} -
Dweblogic.Name=${SERVER_
NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy  
${PROXY_SETTINGS} ${SERVER_CLASS
}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} 
${JAAS_LOGIN} -Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}
else
        echo "Redirecting output from WLS window to ${WLS_REDIRECT_LOG}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} 
${JAAS_LOGIN} -Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}  >"${WLS_REDIRECT_LOG}" 2>&1
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fi

Windows - in the WLS_REDIRECT_LOG settings

If “%WLS_REDIRECT_LOG%”==””(
    echo Starting WLS with line:
    echo %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN%  
-Dweblogic.Name=%SERVER_NAME% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
    %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
) else (
echo Redirecting output from WLS window to %WLS_REDIRECT_LOG%
%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS% >”%WLS_REDIRECT_LOG%” 2>&1
)

4. Save and close the application server startup script.

To configure IBM FileNet Workplace XT

1. Enable trust between Content Engine WebLogic domain and the IBM FileNet Workplace XT 
WebLogic domain.

NOTE  If you have already configured a trust on the Content Engine, perform these steps only 
on the Workplace XT server. You will need to use the same password as the one used on the 
Content Engine.

Do the following on both the Content Engine application server and the IBM FileNet Workplace 
XT application server:

a. Prepare the WebLogic Administration Console for editing.

b. In the advanced security settings for your domain, enter a password for the domain. You 
must enter the same password for both the Content Engine domain and the IBM FileNet 
Workplace XT domain.

c. Save and activate your changes.

d. Restart the server if needed.

e. Repeat this procedure in each domain for which you want to enable trust.

CAUTION  If you are enabling this feature in a managed server environment, you must stop the 
Administration server and all the Managed Servers in both domains and then restart them. If 
this step is not performed, servers that were not rebooted will not trust the servers that were 
rebooted. Refer to your BEA documentation for more information.
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2. Configure LDAP settings on IBM FileNet Workplace XT to exactly match the Content Engine 
settings.

a. Refer to your Content Engine installation worksheet and the WebLogic Administration 
Console settings for Compatibility Security > Realms for Authentication Provider, users, and 
groups on Content Engine.

b. Configure the same LDAP settings on the IBM FileNet Workplace XT Server.

c. Restart the application server. 

3. If you plan to use user tokens (optional), continue with “(optional) To configure WebLogic to 
support user tokens for Workplace XT (including Application Integration, eForms, Records Manager, 
and others)” on page 53.

4. If you do not plan to use user tokens, continue with “Deploy IBM FileNet Workplace XT 
(WebLogic)” on page 65.

(optional) To configure WebLogic to support user tokens for Workplace XT (including Application 
Integration, eForms, Records Manager, and others) 

NOTE  The configuration steps that follow enable the generation and acceptance of user tokens on 
the server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop WebLogic, if it is running.

2. (For installations with Content Engine at 4.5.x) Copy the authentication-weblogic.jar file 
from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

WL_home/server/lib/mbeantypes

3. (For installations with Content Engine at 4.0.x) Copy the authentication-weblogic.jar file 
from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles/1.1.2

to here:

WL_home/server/lib/mbeantypes

4. Copy the log4j-1.2.13.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

WL_home/server/lib/mbeantypes

5. Restart the WebLogic server, and log in to the Administration Console.

6. Add a new authentication provider, with a name you choose, and set the type to 
UserTokenAuthenticator.

7. Move the new provider ahead of the LDAP provider in the order.
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8. Configure settings for the new provider:

a. On the Configuration tab, set the Control Flag to SUFFICIENT. Click Save.

b. On the Provider Specific tab, enter the path to the IBM FileNet Workplace XT 
WcmApiConfig.properties file, for example, <install_path>/FileNet/WebClient/
WorkplaceXT/WEB-INF/WcmApiConfig.properties, then click Save.

9. Save and activate changes.

10. Restart the WebLogic server.

Deploy the Workplace XT application. See “Deploy IBM FileNet Workplace XT (WebLogic)” on 
page 65.
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Task 7c: Configure IBM FileNet Workplace XT (JBoss)
This topic covers the configuration of IBM FileNet Workplace XT on JBoss.

NOTE  IBM FileNet Workplace XT uses cookie names for passing session information between 
Workplace XT and the client browser. This session information affects how Workplace XT interacts with 
several applets, such as Process Designer, Search Designer, and Process Simulator. To avoid forcing end 
users to log in individually to each applet, do not configure the application server to use application-unique 
cookie names for the deployed Workplace XT. For best results, use JSESSIONID for the cookie name.

To configure IBM FileNet Workplace XT

Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step.

1. Modify the application server startup script. See “To modify the application server startup script” on 
page 55.

2. Perform additional configuration steps for IBM FileNet Workplace XT. See “To configure IBM 
FileNet Workplace XT (JBoss)” on page 57.

3. (Optional) If you are using Application Integration or another optional product that require user 
tokens, configure JBoss to support it. See “To configure IBM FileNet Workplace XT (JBoss)” on 
page 57.

To modify the application server startup script

1. Stop JBoss, if it is running.

2. Make a backup copy of the application server startup script.

UNIX

run.sh

Windows

run.bat

3. Open the application server startup script for editing. 

4. Edit the Java settings. 

a. Add a line to specify the path to the JDK on the machine where JBoss is installed, as shown 
in the following example:

UNIX

JAVA_HOME=/export/home/apps/jboss/jdk1.5.0_06

Windows

set JAVA_HOME=C:\Program Files\Java\jdk1.5.0_06

NOTE  If your JDK 1.5.0 version is different, substitute your version for the one listed above 
(_06). 
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b. Update the JAVA_OPTS memory settings.

Adjusting this setting prevents the application server from running out of memory, a 
condition in which users would not be able to log in to Workplace XT.

In the first JAVA_OPTS entry, as per the examples below, change the -Xms and -Xmx 
values (bold) for your configuration.

UNIX

JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m 

Windows

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m 

Refer to your application server vendor's recommendation for Initial and Maximum heap 
size values. For IBM specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 14.

c. (Sun JVM users only) Set the value of MaxpermSize in JAVA_OPTS to 128m, as follows:

UNIX

JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m -XX:MaxpermSize=128m

Windows

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m -XX:MaxpermSize=128m

NOTE  This increased value prevents out of memory errors that can stop JBoss.

5. Configure JAAS login. Add the JAAS login entry for your platform, below in bold, to the existing 
entry immediately following the : RESTART in the startup script.

NOTE  Replace the install_path variable in the line you add with the install path for Workplace 
XT. The default location for UNIX is /opt, and for Windows is C:\Progra~1.

NOTE  Your path may be slightly different depending on the version of your client installations, 
or whether you have chosen a custom path for installation. For example, if your Content 
Engine Client is at 4.0.x, this path may include a samples directory under the config directory. 
Verify the location of the jaas.conf.JBoss file before you enter the path.

CAUTION  Enter the JAAS login entry (bold below) as a single line without line breaks. Do not 
copy and paste the text from this guide because hidden formatting can cause problems with 
the entry. Instead, type the entry into the script.

UNIX

:RESTART

"%JAVA%" %JAVA_OPTS% -Djava.security.auth.login.config=”/install_path/FileNet/
WebClient/CE_API/config/jaas.conf.JBoss” "-
Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath "%JBOSS_CLASSPATH%" 
org.jboss.Main %* 
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Windows

:RESTART

"%JAVA%" %JAVA_OPTS% -Djava.security.auth.login.config=install_path\ 
FileNet\WebClient\CE_API\config\jaas.conf.JBoss "-
Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath "%JBOSS_CLASSPATH%" 
org.jboss.Main %*

6. Save and close the application server startup script.

To configure IBM FileNet Workplace XT (JBoss)

1. Stop JBoss, if it is running.

2. Configure LDAP settings on the Workplace XT server to exactly match the Content Engine 
settings.

NOTE  Create a backup of the login-config.xml file before making changes.

a. On the Workplace XT server, open login-config.xml, located in JBoss_home/server/
server_name/conf, for editing.

b. Add an identical <application-policy name="FileNet"> entry to match the corresponding 
entry in the login-config.xml file on the Content Engine server.  This should be added at the 
end of the file before the final </policy> line.

<authentication>
<login-module code="org.jboss.security.auth.spi.UsersRolesLoginModule" 
flag="required"/>

</authentication>
</application-policy>

<application-policy name="FileNet">
<authentication>

<login-module code="org.jboss.security.auth.spi.LdapExtLoginModule" 
flag="sufficient">

<module-option name="java.naming.provider.url">ldap://cm-nihuevm9:389</
module-option>
<module-option name="java.naming.security.authentication">simple</module-
option>
<module-option name="allowEmptyPasswords">false</module-option>
<module-option 
name="bindDN">cn=ceadmin,ou=shared,ou=engineering,ou=filenet,dc=apple</
module-option>
<module-option name="bindCredential">Password1</module-option>
<module-option name="baseCtxDN">dc=apple</module-option>
<module-option name="baseFilter">(cn={0})</module-option>
<module-option name="rolesCtxDN">dc=apple</module-option>
<module-option name="roleFilter">(cn={0})</module-option>
<module-option name="roleAttributeID">memberOf</module-option>
<module-option name="roleAttributeIsDN">true</module-option>
<module-option name="roleRecursion">-1</module-option>

</login-module>
</authentication>

</application-policy>
</policy>

NOTE You can copy this entry from the Content Engine login-config.xml file. If you have no 
custom entries in the file on your Workplace XT server, you can copy the entire file from the 
Content Engine, and overwrite the login-config.xml file on the Workplace XT server.
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 7c: Configure IBM FileNet Workplace XT (JBoss)
To configure IBM FileNet Workplace XT (JBoss)

58
3. Set permissions for the user running the application server.

If the user who will be running the application server is different from the user that installed 
IBM FileNet Workplace XT, you must give the user read/write permissions on the following 
folder:

install_path/FileNet/WebClient

NOTE For Windows, this is only required for NTFS formatted partitions.

4. Delete the following directory:

JBoss_home/server/server_name/deploy/jbossweb-tomcat55.sar/jsf-libs

NOTE  If you have applications that depend on the default configuration jsf-libs, you can 
create a new configuration and deploy Workplace XT to it.  See the JBoss Application Server 
Guide  (search for this guide at (http://docs.jboss.org) for details.

5. Clear out all files and folders within the following temp directories:

JBoss_home/server/server_name/tmp/deploy
JBoss_home/server/server_name/work/jboss.web/localhost

6. Disable JBoss logging to prevent unexpected behavior in the deployed IBM FileNet software. 

NOTE  When logging is disabled, error messages will still be displayed in the JBoss console.

a. Open the log4j.xml file (JBOSS_home/server/server_name/conf/log4j.xml) for 
editing.

b. Add the following line (in bold) for the FILE appender, under the section “Preserve 
messages in a local file”:

<!-- A time/date based rolling appender -->
<appender name="FILE" class= 
"org.jboss.logging.appender.DailyRollingFileAppender">

<errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>
<param name="File" value="${jboss.server.log.dir}/server.log"/>
<param name="Append" value="false"/>
<param name="Threshold" value="ERROR"/>

c. Change all threshold values and priority values from

"INFO"

"DEBUG"

"TRACE" 

to

"ERROR"

except for the CONSOLE appender threshold value, which should be set to “INFO”, as 
shown in bold below:

<appender name="CONSOLE" class="org.apache.log4j.ConsoleAppender">
<errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>
<param name="Target" value="System.out"/>
<param name="Threshold" value="INFO"/>
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d. Add IBM FileNet-specific categories to avoid excessive tracing messages in the console, 
which can impact performance. Add the following at the end of the “Limit categories” section,  
just before the “Setup the Root category” section:

<category name="filenet_error.api">
<priority value="ERROR"/>

</category>

<category name="filenet_tracing.api">
<priority value="OFF"/>

</category>

<category name="com.filenet.wcm.api">
<priority value="ERROR"/>

</category>

<category name="com.filenet-trace">
<priority value="OFF"/>

</category>

<category name="com.filenet-debug">
<priority value="ERROR"/>

</category>

NOTE  If other IBM FileNet-specific tracing message in the command console affect 
performance, add additional categories for those messages.

e. Remove the Root category priority value, if any, as shown in bold below:

<!-- ======================= -->
<!-- Setup the Root category -->
<!-- ======================= -->

<root>
<priority value="ERROR"/>
<appender-ref ref="CONSOLE"/>
<appender-ref ref="FILE"/>

</root>

f. Save and close the log4j.xml file.

7. (optional) Start JBoss as follows, to verify that configuration changes were successful:

UNIX

./run.sh

Windows

run.bat

8. If you plan to use user tokens (optional), continue with “(optional) To configure JBoss to support 
user tokens for Workplace XT (including Application Integration, eForms, Records Manager, and 
others)” on page 60.

9. If you do not plan to use user tokens, continue with “Deploy IBM FileNet Workplace XT (JBoss)” on 
page 67.
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(optional) To configure JBoss to support user tokens for Workplace XT (including Application 
Integration, eForms, Records Manager, and others) 

The configuration steps that follow enable the generation and acceptance of user tokens on the 
server. These settings can be verified in the Bootstrap Settings in the Site Preferences.

1. Stop JBoss, if it is running.

2. (For installations with Content Engine at 4.5.x) Copy the authentication-utils.jar file 
from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

JBOSS_home/server/server_name/default/lib

3. (For installations with Content Engine at 4.0.x) Copy the authentication-utils1.1.2.jar 
file from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles/1.1.2

to here:

JBOSS_home/server/server_name/default/lib

4. Modify the login-config.xml file. 

NOTE  Create a backup of the file before making changes.

a. On the Workplace XT server, open login-config.xml in JBoss_home/server/
server_name/conf for editing.

b. Add the following xml element (bold below) as the first entry in the FileNet domain section, 
and set the flag to “optional”:

<application-policy name="FileNet">

<authentication>

<login-module code= 
"com.filenet.ae.authentication.loginmodule.UserTokenLoginModule" 
flag="optional">
   <module-option name="wcmApiConfigPath"><install_path>/FileNet/
    WebClient/WorkplaceXT/WEB-INF/WcmApiConfig.properties
   </module-option>
   <module-option name="multi-threaded">true</module-option>
</login-module>
<login-module code="org.jboss.security.auth.spi.LdapExtLoginModule" 
flag="required">
     <module-option name="java.naming.provider.url">ldap://
copenhagen:389</module-option>
     <module-option name="java.naming.security.authentication">simple</
module-option>
     <module-option name="allowEmptyPasswords">false</module-option>
     <module-option 
name="bindDN">CN=CEAdmin,OU=Shared,OU=Engineering,OU=FileNet,DC=FileNet,D
C=Com</module-option>
     <module-option name="bindCredential">MyPassword</module-option>
     <module-option name="baseCtxDN">DC=FileNet,DC=Com</module-option>
     <module-option name="baseFilter">(cn={0})</module-option>
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     <module-option name="rolesCtxDN">DC=FileNet,DC=Com</module-option>
     <module-option name="roleFilter">(cn={0})</module-option>
     <module-option name="roleAttributeID">memberOf</module-option>
     <module-option name="roleAttributeIsDN">true</module-option>
     <module-option name="roleRecursion">-1</module-option>
</login-module>

</authentication>

</application-policy>

NOTE  On Windows, use double back slash (\\) in place of the forward slash in the 
wcmApiConfigPath entry, as shown below:

<module-option name="wcmApiConfigPath">
<install_path>\\FileNet\\WebClient\\WorkplaceXT\\WEB-
INF\\WcmApiConfig.properties</module-option>

NOTE  When deploying as an EAR or WAR file, the wcmApiConfigPath value must be a 
valid folder path, such as the install location. It cannot point to a folder within the EAR or 
WAR file.

c. Save changes to login-config.xml.

Deploy the Workplace XT application. See “Deploy IBM FileNet Workplace XT (JBoss)” on page 67.
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Task 8a: Deploy IBM FileNet Workplace XT 
(WebSphere)
This topic covers the deployment and start of the IBM FileNet Workplace XT application on 
WebSphere. 

To recreate the WAR and EAR files

NOTE  If you are using a WAR file or EAR file for deployment, you must recreate the WAR file or 
WAR and EAR files and redeploy the application each time you make changes to files in the
/FileNet/WebClient/WorkplaceXT directory. If you chose not to have the Content Engine or 
Process Engine Client installers create your deployment file, or if you made changes to web.xml 
for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists. To recreate the 
WAR file, run one of the following commands:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and 
web_client.ear exist. To recreate the EAR file, first recreate the WAR file, and then run the 
following command to recreate the EAR file:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_ear.bat

To deploy Workplace XT

1. From the WebSphere administrative console, navigate to the dialog for installing a new 
application. 

2. Select the file to deploy:

• (If the administrative console is running locally) Select Local file system and enter or browse to the 
location of the .war or .ear file created by the setup program (see below for the default path). Do 
not enter the machine name.

• (If the administrative console is remote) Select Remote file system and enter the fully-qualified 
path to the .war or .ear file. Do not enter the machine name.

The default path is install_path/FileNet/WebClient/deploy

3. If you are deploying a WAR file, enter the context root: 

Enter WorkplaceXT and click Next to proceed to deploying a new application.
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NOTE  The context root is the name of the application you log in to using the web interface, 
such as http://WorkplaceXTServerName:port#/Context_Root. Do not include any spaces in 
the context root.

4. Complete the dialog boxes for installing a new application, using the following settings:

NOTE  For any settings not specified here, accept the defaults.

• Show me all installation options and parameters: selected

• Application name: Workplace XT, or the name you chose to call the application.

• WebServer: The server you are planning to use. Verify that your application name is selected and 
associated with the correct WebServer.

• Map virtual hosts for Web modules: select WorkplaceXT or the name you chose to call the 
appplication

5. Finish the install and save it to the master configuration.

NOTE  Do Step 6 to Step 8 for each specific web application deployment only. Do not change 
the similar settings for the entire application server.

6. Configure the Class loader setting so that the parent class loader is loaded last. 

7. Update the polling interval to a number appropriate for your environment.

8. For the Workplace XT (or the name of your application) web module, configure the Class loader 
setting so that the parent class loader is loaded last.

9. Save your changes to the master configuration.

10. Navigate to Enterprise Applications > Workplace > Map security roles to users/groups, and 
verify that the All Authenticated column is checked for the "All Authenticated" role, and that the 
Everyone? column is checked for the “Everyone” role.

11. Set permissions for the user running the application server.

If the local user who will be running the application server is different from the user who 
installed IBM FileNet Workplace XT, you must give the user read/write permissions on the 
following (default) folders:

WAS_HOME/profiles/default/installedApps/node_name/WorkplaceXT.ear/
web_client.war

install_path/FileNet/WebClient

12. (Windows only) From the Windows Services Console, restart the Process Workplace XT 
Services Manager service. 

13. Restart Process Task Manager and Component Manager.
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14. Exit the Process Task Manager application.

15. Start Workplace XT from the administrative console.

NOTE To troubleshoot the deployment, check the following log:

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log
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Task 8b: Deploy IBM FileNet Workplace XT (WebLogic)
This topic covers the deployment of your IBM FileNet Workplace XT application on WebLogic.

To recreate the WAR and EAR files (optional)

NOTE  If you are using a WAR file or EAR file for deployment, you must recreate the WAR file or 
WAR and EAR files and redeploy the application each time you make changes to files in the
/FileNet/WebClient/WorkplaceXT directory. If you chose not to have the Content Engine or 
Process Engine Client installers create your deployment file, or if you made changes to web.xml 
for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists.To recreate the 
WAR file, run one of the following commands:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and 
web_client.ear exist. To recreate the EAR file, first recreate the WAR file, and then run the 
following command to recreate the EAR file:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_ear.bat

To rename the WAR file (optional)

NOTE  This step is optional. Perform this step only if you are using a WAR file for deployment, and 
you want to use “Workplace XT” or a custom name for the context root of the application. The 
context root is part of the URI that end users type to access Workplace XT. 

By default, when you deploy from a WAR file, the context root is the first part of the WAR filename. 
For example, the default web_client.war will generate a context root of http://server_name:port#/
webclient. If you want to use http://server_name:port#/custom_name, you must rename 
web_client.war to custom_name.war.

1. Use the rename command to rename the WAR file. Enter the command without the line break.

UNIX

rename install_path/FileNet/WebClient/deploy/web_client.war  
     install_path/FileNet/WebClient/deploy/custom_name.war 

Windows

rename install_path\FileNet\WebClient\deploy\web_client.war  
     install_path\FileNet\WebClient\deploy\custom_name.war 
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To deploy IBM FileNet Workplace XT (WebLogic 9.2)

1. Use the WebLogic Administration Console to deploy Workplace XT. 

You can deploy the application in one of the following ways:

• To deploy from an exploded folder, choose the Workplace XT folder in install_path/
FileNet/WebClient 

• To deploy from a WAR or EAR file, choose the web_client.war or web_client.ear file in 
install_path/FileNet/WebClient /deploy 

2. Accept the defaults for the deployment, except for the name for the deployment. Use “Workplace 
XT” or the custom name you have chosen instead of “web_client”.

3. Finish and save your changes.

NOTE  To verify that the deployment was successful, expand Web Applications. The web 
application name you specified for Workplace XT will be listed.

4. After IBM FileNet Workplace XT is deployed, start the application from the WebLogic 
Administration Console.

5. (Windows only) From the Windows Services Console, restart the Process Workplace XT 
Services Manager service. 

6. Restart Process Task Manager and Component Manager. 

7. Exit the Process Task Manager application.

NOTE To troubleshoot the deployment, check the following log:

WLS_install_path/user_projects/domains/domain_name/servers/server_name/logs/
server_name.log
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Task 8c: Deploy IBM FileNet Workplace XT (JBoss)
This topic covers the deployment and start of Workplace XT on JBoss.

To recreate the WAR or EAR files (optional)

NOTE  If you are using a WAR file or EAR file for deployment, you must recreate the WAR file or 
WAR and EAR files and redeploy the application each time you make changes to files in the
install_path/FileNet/WebClient/WorkplaceXT directory. If you chose not to have the 
Content Engine or Process Engine Client installers create your deployment file, or if you made 
changes to web.xml for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists. To recreate the 
WAR file, run one of the following commands:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and 
web_client.ear exist. To recreate the EAR file, first recreate the WAR file, and then run the 
following command to recreate the EAR file:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_ear.bat

To deploy  as “Workplace XT” or custom name using a WAR file (optional)

NOTE  This step is optional. Perform this step only if you are using a WAR file for deployment, and 
you want to use “Workplace XT” or a custom name for the context root of the application. The 
context root is part of the URI that end users type to access Workplace XT. 

By default, when you deploy from a WAR file, the context root is the first part of the WAR filename. 
For example, the default web_client.war will generate a context root of http://
<server_name>:<port#>/webclient. If you want to use http://server_name:port#/custom_name, you 
must rename web_client.war to custom_name.war.

1. Use the rename command to rename the WAR file. Enter the command without the line break.

UNIX

rename install_path/FileNet/WebClient/deploy/web_client.war  
     install_path/FileNet/WebClient/deploy/custom_name.war 

Windows

rename install_path\FileNet\WebClient\deploy\web_client.war  
     install_path\FileNet\WebClient\deploy\custom_name.war 
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CAUTION  You must rename the WAR file every time you regenerate it. The 
create_web_client_war.sh/.bat script will by default create a file with the name 
web_client.war.

To deploy Workplace XT

1. Stop JBoss, if it is running.

2. Deploy Workplace XT

• (For exploded directory deployment only)

i. On the JBoss server, copy the WorkplaceXT folder from: 

install_path/FileNet/WebClient/

to:

JBOSS_home/server/server_name/deploy/

ii. Append the extension .war to the WorkplaceXT folder:

JBOSS_home/server/server_name/deploy/WorkplaceXT.war

iii. (optional) For a custom name for the context root (and the application), rename the 
WorkplaceXT.war folder to custom_name.war, where custom_name is the name you 
choose for your application.

• (For WAR file deployment only) 

i. On the JBoss server, copy the web_client.war (or custom_name.war) file from:

install_path/FileNet/WebClient/deploy/

to:

JBOSS_home/server/server_name/deploy/

• (For EAR file deployment only) 

i. On the JBoss server, copy the web_client.ear file from: 

install_path/FileNet/WebClient/deploy/

to:

JBOSS_home/server/server_name/deploy/

3. Start or restart the JBoss application server.

4. Verify that the application deployed successfully.

Verify that the server.log file located in JBOSS_home/server/server_name/log lists 
deployment of the WAR or EAR file you used.

5. (Windows only) From the Windows Services Console, restart the Process Workplace XT 
Services Manager service. 
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



Task 8c: Deploy IBM FileNet Workplace XT (JBoss)
To deploy Workplace XT

69
6. Restart Process Task Manager and Component Manager. 

7. Exit the Process Task Manager application.
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Configuration and startup tasks
To configure IBM FileNet Workplace XT components, perform the following tasks:

• “Set IBM FileNet Workplace XT bootstrap preferences” on page 71.

• “Configure the Process Engine Connection Point for IBM FileNet Workplace XT” on page 75.

• “Configure the Process Engine REST services connection” on page 76

• “Set up SSL security for IBM FileNet Workplace XT” on page 77.

• “Perform additional configuration tasks” on page 81.
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Set IBM FileNet Workplace XT bootstrap preferences
Bootstrap preferences are a category of site preferences. The first time you log into IBM FileNet 
Workplace XT, the Bootstrap Preferences page opens, displaying the following five bootstrap 
preference groups:

• Security Info (required only when using Application Integration with SSL)

• User Token Settings

• Preference Settings (required)

• Application Integration

• Administrator Access Role

For more information, see the IBM FileNet P8 Help topic User Help > Actions, preferences, and tools 
> Site preferences >  Bootstrap preferences.

NOTES 

• By successfully logging in to IBM FileNet Workplace XT and saving the bootstrap preferences, 
you are verifying IBM FileNet Workplace XT basic functionality such as user authentication, 
communication, and storing of data in Content Engine.

• In addition to the preferences covered in this topic, more preferences can be set for the 
Workplace XT application using Workplace XT Site Preferences. For more information, see 
the IBM FileNet P8 Help topic User Help > Actions, preferences, and tools > Site preferences.

• After the initial bootstrap configuration, users with the Application Engine Administrators role 
can change any of these preferences by signing into IBM FileNet Workplace XT and 
navigating to Admin > Site Preferences > Bootstrap. 

• In a web farm/clustered environment, all Workplace XT installations share site preferences by 
using the same bootstrap.properties file. For more information, see the IBM FileNet P8 
Platform High Availability Technical Notice. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 14.

• Bootstrap properties are stored in a separate file from other site preferences. The default 
location for this file, bootstrap.properties, is:

install_path/FileNet/Config/WebClient

• To allow users to create workflow subscriptions, you must configure the PWDesigner access 
role. For more information, see “To enable user access to the Workflow Subscription Wizard” on 
page 74.

To set the bootstrap properties on first login

1. Log in to Workplace XT: 

a. On any computer, open a browser and type:

http://WorkplaceXTServerName:port#/WorkplaceXT
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b. Enter a user name and password, and then click Log in. The Bootstrap Preferences page 
opens. 

NOTE  The user who initially logs in and sets the bootstrap preferences is automatically 
added to the Application Engine Administrators role. For more information, see the IBM 
FileNet P8 Help topic User Help > Actions, preferences, and tools > Site preferences > Access 
Roles preferences. 

2. (Required only when using Application Integration with SSL) Enter security info.

a. Enter the SSL Host and Port information for the SSL server.

b. Enter the Java Server HTTP port.

Use the Security info preference to redirect Application Integration log-ins through a Secure 
Socket Layer (SSL) server and to identify a remote Java server. This encrypts the user IDs 
and passwords when they travel over the network. See “Set up SSL security for IBM FileNet 
Workplace XT” on page 77 for instructions on setting up SSL security for one or more IBM 
FileNet Workplace XT installations.

3. Configure user token settings. 

For Workplace XT, you can change the Token timeout interval (1-15).

4. (Required) Specify preference settings.

Preference settings specify the name of the site preference file, its storage location (object 
store), and the documentation server URL (if installed). The site preferences file is checked 
into the object store the first time you log in to IBM FileNet Workplace XT. The site preferences 
are stored as XML data in this file, Site Preferences for Preferences name.xml. Use 
Enterprise Manager to access this file, and navigate to Object Stores > Object Store location > 
Root Folder > Preferences.

NOTE  The bootstrap preferences are saved in the bootstrap.properties file, and not in the 
site preferences file.

a. Select an object store from the Object store location choice list. The preferences file will be 
saved in this object store. Workplace XT users must have access to this object store.

b. Enter a preference file name in the Preferences name field.

c. Enter the documentation server URL in the Documentation server field. 

The format of the URL is:

http://DocServerName:port#/ecm_help

where DocServerName is the name of your Java application server where the 
documentation is installed,
port# is the port number,
and ecm_help is the root directory of the documentation web site.

NOTE  If no documentation URL is specified, the IBM FileNet Workplace XT Help link will 
default to 
http://localhost. 

5. Add IBM FileNet Workplace XT Administrators (Application Engine Administrators).
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Add the users and groups that will perform IBM FileNet Workplace XT administration tasks to 
the Application Engine Administrators role. 

NOTES 

• The user who initially signs in and sets the bootstrap preferences is automatically added to the 
Application Engine Administrators role. For more information, see the IBM FileNet P8 Help topic 
User Help > Actions, preferences, and tools > Site preferences > Access Roles preferences.

• To modify the access roles after the initial bootstrap configuration, users with the Application 
Engine Administrators role can use the access roles section of the IBM FileNet Workplace XT Site 
Preferences. Launch IBM FileNet Workplace XT and navigate to Admin > Site Preferences > 
Access Roles. 

6. Click Apply to save your bootstrap settings.

To verify that a single index has been added for Application Name on the site preferences object 
store

To properly index access roles and improve login performance on IBM FileNet Workplace XT, an 
index is created for Application Name on the object store that contains the Workplace site 
preferences. Verify this index setting after you have successfully configured the bootstrap 
preferences.

1. Launch the IBM FileNet Enterprise Manager.

2. In the left pane, expand the Object Stores folder.

3. Expand the object store node where your preferences are stored. See “(Required) Specify 
preference settings.” on page 72 above.

4. Expand Other Classes and then Custom Object.

5. Right click Access Role and select Properties.

6. Select the Property Definitions tab.

7. Select Application Name and click Edit.

8. On the General tab of the Application Name Properties, verify that the Indexed field shows 
Single Indexed.  

– If the Indexed field shows Single Indexed., continue at Step 13.

– If the Indexed field shows 'not indexed', continue at Step 9.

9. Click Set/Remove.

10. Select Set and then Single Indexed.

11. Click OK to set the index.  

12. Click OK to apply the change and close the Application Name Properties window.  

13. Click OK to close the Access Role Class Properties window.
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To enable user access to the Workflow Subscription Wizard

To allow users to create workflows subscriptions, you must configure the PWDesigner access role 
using the Workplace Site Preferences, and give the users appropriate access rights to the 
workflow subscriptions classes. You can perform these steps in any order, and you must perform 
both steps any time you need to add or remove users.

1. Assign users as members of the PWDesigner access role. See the IBM FileNet P8 Help topic 
User Help > Actions, preferences, and tools > Site preferences > Access Roles preferences.

2. Run the security script wizard and load the workplacescript.xml file, located on the Content 
Engine at install_path/FileNet/ContentEngine/Scripts/WorkplaceScript.xml, to 
add accounts to the Workflow Designer role.

For more information about how to use the Security Script wizard to assign the Workflow 
Designer role to user or group accounts, see the IBM FileNet P8 Help topic FileNet P8 
Administration > Content Engine Administration > Content Engine Wizard Help > Security Script.

For more information about the workplacescript.xml file and how roles are defined in the 
Enterprise Manager, see the IBM FileNet P8 Help topic FileNet P8 Administration > Content 
Engine Administration > Managing Security > Security Script Wizard.
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Configure the Process Engine Connection Point for 
IBM FileNet Workplace XT
Before users can access tasks and work items from IBM FileNet Workplace XT, you must 
configure the Connection Point on the Workplace XT server. Make sure that you have already 
completed the following tasks in the IBM FileNet P8 Platform Installation and Upgrade Guide:

• Create a Process Engine Isolated Region

• Create a Process Engine Connection Point

To download this and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14.

To configure the connection point

1. Log into IBM FileNet Workplace XT: 

a. On any computer, open a browser and navigate to:

http://WorkplaceXTServerName:port#/WorkplaceXT

b. Sign in using the same account that you used to set the bootstrap preferences. 

2. Click Admin.

3. Click Site Preferences.

4. On the General Settings page, under Tasks, select a Process Engine Connection Point from the 
drop down list.

5. Click Apply, then click Exit.

CAUTION  Performing Step 6 in an existing environment will destroy all data in the existing region.

6. (For new environments only) Initialize the isolated region.

a. Click Admin.

b. Click Process Configuration Console.

c. Right-click the icon or name of the isolated region you want to initialize, and select Connect 
from the context menu. 

d. Click Action.

e. Click Initialize Isolated Region. 

f. Click Yes at the prompt asking if you want to continue. 

a. Close the Process Configuration Console.

7. In IBM FileNet Workplace XT, click Tasks to confirm that IBM FileNet Workplace XT is 
communicating with Process Engine. 

8. Sign out of Workplace XT. 
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Configure the Process Engine REST services 
connection
If you plan to use the ECM Widgets component, or want to use Process Engine REST services 
directly, configure the Process Engine REST services connection by editing the 
P8BPMRESTConfig.xml file.

(Optional) To configure the Process Engine REST services connection

1. Navigate to install_path/FileNet/WebClient/WorkplaceXT/WEB-INF.

2. Open P8BPMRESTConfig.xml for editing.

3. Locate the entries for the Content Engine Bootstrap URI and the connection point, near the top 
of the file:

<perest:filenet.pe.bootstrap.ceuri value="iiop://cm-peru:2809/FileNet/Engine"/>
<perest:connection.point value="RESTCP"/>

4. Replace these entries with the values for your environment:

– Replace cm-peru:2809 with your Content Engine server name and port number.

– Replace RESTCP with the name of your connection point. 

Do not change the name if you have created a connection point for REST services that is 
called RESTCP.

5. Save your changes and close the file.
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Set up SSL security for IBM FileNet Workplace XT
This topic describes how to configure IBM FileNet Workplace XT to direct sign-ins through a 
Secure Socket Layer (SSL) https connection. It assumes that Workplace XT has already been 
installed.

Workplace XT supports the following methods of configuring an SSL environment:

• Full SSL support - A single IBM FileNet Workplace XT server, where all of the software is 
running under SSL.

• One server SSL redirect - One IBM FileNet Workplace XT server set up to redirect logon 
attempts on the non-SSL port to the SSL port.

To set up full SSL support on a single IBM FileNet Workplace XT Server

1. Enable SSL on the application server that runs Workplace XT (see your SSL documentation).

2. Test the SSL connection by logging into Workplace XT using the following URL:

https://WorkplaceXTServerName:SSL port/WorkplaceXT

NOTE  The entire log-in process will be handled by the SSL-enabled host.Under full SSL, after 
login, all pages and information will be handled in SSL.

For more information about SSL port numbers, see “IBM FileNet Workplace XT port numbers” on 
page 133.

To set up SSL redirect on a single IBM FileNet Workplace XT server

1. Enable SSL on the application server that runs IBM FileNet Workplace XT (see your SSL 
documentation).

2. (optional) (WebSphere and WebLogic only) If you have made custom changes to your web.xml 
file, copy the web.xml file from the deploy location:

• WebSphere: 

WAS_HOME/profiles/default/installedApps/node_name/WorkplaceXT.ear/
web_client.war

• JBoss

JBOSS_HOME/server/server_name/deploy/application_name.war or .ear

back into the install location (install_path/FileNet/WebClient/WorkplaceXT/WEB_INF) 
before editing for SSL redirect.

3. Create a backup copy of your web.xml file.

4. (WebSphere only) Modify the web.xml file in the install_path/FileNet/WebClient/
WorkplaceXT/WEB_INF directory:

a. Copy the <security_constraint> section from your file (not from this document), as shown in 
Step b below, and paste the new copied section directly after the original.
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b. Make changes to the newly inserted <security_constraint> section as follows (changes in 
bold):

Change from

<security-constraint>
<web-resource-collection>

<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/</url-pattern>
<url-pattern>/*</url-pattern>

</web-resource-collection>
<auth-constraint>

<role-name>All Authenticated</role-name>
</auth-constraint>
<user-data-constraint>

<description>User data constraints</description>
<transport-guarantee>NONE</transport-guarantee>

</user-data-constraint>
</security-constraint>

  to

<security-constraint>
<web-resource-collection>

<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/ContainerLogin.jsp</url-pattern>

</web-resource-collection>
<auth-constraint>

<role-name>All Authenticated</role-name>
</auth-constraint>
<user-data-constraint>

<description>User data constraints</description>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>

</user-data-constraint>
</security-constraint>

NOTE  The change also removes the second occurrence of this line:

<url-pattern>/*</url-pattern>

c. Save your changes to the web.xml file.

5. (WebLogic and JBoss only) Modify the web.xml file in the <install_path>/FileNet/
WebClient/WorkplaceXT/WEB_INF directory:

a. In the <security_constraint> section, change the parameter, as follows, from

<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee>NONE</transport-guarantee>

</user-data-constraint>

to

<user-data-constraint>
<description>User data constraints</description>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>

</user-data-constraint>

b. Save your changes to the web.xml file.
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6. Create your deployment files.

– (If you deployed as a WAR file only), In the install_path/FileNet/WebClient/deploy 
directory, run create_web_client_war.sh or .bat file.

– (If you deployed as an EAR file only), In the install_path/FileNet/WebClient/deploy 
directory, run create_web_client_war.sh or .bat file, then create_web_client_ear.sh 
or .bat file.

7. Redeploy the application.

8. Sign in to Workplace XT:

a. On any computer, open a browser and type the following URL address:

http://WorkplaceXTServerName:port#/WorkplaceXT

b. Sign in as a user with Application Engine Administrator access role privileges. For more 
information, see the IBM FileNet P8 Help topic User Help > Actions, preferences, and tools > 
Site preferences > Access Roles preferences.

9. (Applies only when using Application Integration) Set bootstrap preferences:

a. Navigate to Tools > Administration > Site Preferences > Bootstrap.

b. Set the Security info Site Preference SSL Host:Port to identify the alias host name and port 
number.

Use the IP address of the IBM FileNet Workplace XT server for the SSL Host entry.

For more information, see “(Required only when using Application Integration with SSL) Enter 
security info.” on page 72.

c. Click Apply to save your bootstrap settings.

10. Update the base URL:

a. Navigate to Tools > Administration > Site Preferences > Refresh.

b. Enter the Workplace XT Base URL value in the provided field. The URL must contain a valid host 
name, and not contain “localhost" or an IP number. For example, http://myserver:port/
WorkplaceXT.

For more information, see the IBM FileNet P8 Help topic User Help > Actions, preferences, and 
tools > Site preferences > Refresh preferences.

c. Click Refresh to update the base URL.

d. Click Exit to close Site Preferences.

11. Sign out of Workplace XT, and close your browser.

12. Test the SSL connection by signing into Workplace XT using the following URL:

http://WorkplaceXTServerName:non-SSL port/WorkplaceXT

NOTE  You will be redirected to the SSL-enabled port for log in, then back to the non-SSL 
enabled port after log-in is complete. You should receive a warning that you are accessing 
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pages over a secure connection (unless you turned this dialog box off), then Workplace XT will 
open.

Using Java Applets in an SSL Environment
If you are using a Java applet in an SSL environment, you may experience an 
SSLHandshakeException because the appropriate certificate does not exist on your computer. 
Follow the instructions in the IBM FileNet P8 Help topic User Help > Using Workplace > Basics > Use 
Java Applets to resolve this issue.
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Perform additional configuration tasks
Once you have completed the installation and configuration tasks, your Workplace XT application 
will be up and running. Below is a list of additional configuration tasks you can complete (or at 
least review) to prepare the system for general use. Except where noted, the links go to the IBM 
FileNet P8 Help, and start from the Contents panel in:

http://webserver:port#/ecm_help/_start_here.htm 

where webserver:port are the application server and port for your IBM FileNet P8 help.

• Set site preferences for the Workplace XT application. Refer to User Help > Actions, preferences, 
and tools > Site preferences.

• Configure email notification. Refer to FileNet P8 Administration > Process Engine Administration > 
Workflow administration tasks > Coordinating workflow design > Email notification.

• Enable logging. Refer to User Help > Using Workplace XT > Configure Workplace XT > Configure 
Logging.

• Perform other configuration tasks as applicable. For a list of tasks that apply to the full IBM 
FileNet P8 system, see the “Perform Additional Configuration Tasks” in the IBM FileNet P8 
Platform Installation and Upgrade Guide. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 14.
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NOTE  You can install the additional or optional IBM FileNet Workplace XT components listed 
below in any order.

• “Install IBM FileNet Workplace XT Application Integration” on page 83.

• “Install IBM FileNet Workplace XT File Tracker” on page 88.

• “Install Application Integration BCS for Microsoft Office (Workplace XT)” on page 91

• “Deploy multiple IBM FileNet Workplace XT instances” on page 98.
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Install IBM FileNet Workplace XT Application 
Integration
Install Application Integration if you want to integrate IBM FileNet Workplace XT with your 
Microsoft® Office applications and Outlook. Complete the following procedure on each machine 
that will use Workplace XT Application Integration.

NOTES 

• Verify that the client machine meets the platform requirements documented in the IBM FileNet 
P8 Hardware and Software Requirements. To download this and other IBM FileNet product 
documentation from the IBM web site, see “Access IBM FileNet Documentation, Compatibility 
Matrices, and Fix Packs” on page 14.

• You cannot collocate IBM FileNet Workplace XT Application Integration with clients running P8 
Workplace Application Integration Toolkit.

• If you plan to use Application Integration with Workplace XT, you must configure your 
application server to support user token settings. See the following procedures for details:

– “(optional) To configure WebSphere to support user tokens for Workplace XT (including 
Application Integration, eForms, Records Manager, and others)” on page 41

– “(optional) To configure WebLogic to support user tokens for Workplace XT (including Application 
Integration, eForms, Records Manager, and others)” on page 53

– “(optional) To configure JBoss to support user tokens for Workplace XT (including Application 
Integration, eForms, Records Manager, and others)” on page 60

To install the Application Integration software interactively

1. Log in to the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. Click Tools > Downloads > Download Application Integration for Microsoft(R) Office....

4. In the dialog, do one of the following:

• Click Run to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save. Once the file is saved to your 
hard drive, double-click the file to run the installer.

A setup preparation dialog appears momentarily, followed by the Welcome dialog box for 
Workplace XT Application Integration.

5. Click Next.

6. Read and accept the license agreement, and then click Next. If you do not accept the license 
agreement, you cannot continue with the install. 

7. Do the following:
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• Select the applications you want to integrate, and then click Next.

KEYBOARD TIP Use arrow keys to move up and down the list of applications. Use the 
space bar to access the context menu for any of the applications, and then use the arrow 
keys to select a feature and press Enter.

NOTE  The Application Integration Toolkit Components option is required to use 
Application Integration. 

• Under Install to, the default installation path is displayed. Click Change to specify a different 
location on the Change Current Destination Folder dialog box, and then click OK. Click Next.

NOTE  You may see two default installation paths - one for Microsoft Office and Outlook, 
and another for the Toolkit Components. The Toolkit Components path only appears when 
the system on which you are installing Application Integration has the Toolkit Components 
currently installed. You cannot modify the Toolkit Components installation path.

8. Enter the server name, port number, and application name that defines the IBM FileNet 
Workplace XT address. The Server Name is the name of the web server running Workplace XT, 
Port is the web server’s assigned port, and Application is the name of your application, for 
example, Workplace XT.

Check Server uses secure connection (SSL) if you are running full SSL to encrypt all 
communication with Workplace XT. 

Check Server uses single sign-on (SSO) if you are using Application Integration in an SSO 
environment.

NOTE  You can also leave these fields blank and enter the information when you log in to 
Workplace XT Application Integration.

9. Click Next.

10. Click Install.

11. After the install is complete, click Finish to complete the setup process.

To install the Application Integration software silently

1. Log onto the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. Click Tools > Downloads > Download Application Integration for Microsoft(R) Office....

4. Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save.

5. Open a DOS command window and change the current directory to the one where 
ApplicationIntegration.exe resides.

6. Type (do not copy and paste) the following at the command line:

ApplicationIntegration.exe /s /v"/qn <additional arguments included in string> 
LICENSE_ACCEPTED=true"

Use the /s switch and include the /qn switch to launch the install silently.
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Refer to the following optional command line values you can also use. Append the values within the string 
containing the arguments.

For example, ApplicationIntegration.exe /s /v"/qn /L*v C:\temp\AppIntSetup.txt 
LICENSE_ACCEPTED=true"

Command Line Values Installs

ADDLOCAL=ALL All Features

ADDLOCAL=ALL  
REMOVE=OutlookIntegrationFeature 

Office Only

ADDLOCAL=ALL  
REMOVE=OfficeIntegrationFeature

Outlook Only

ADDLOCAL=ALL 
REMOVE=OutlookIntegrationFeature,
OfficeIntegrationFeature

Core Only

Command Line Values Settings

HOST=host name Enter the name of the web server running 
Workplace XT.

PORT=port number Enter the web server’s assigned port number.

APPLICATION=application name Enter the directory in which you installed the 
Workplace XT application files.

SERVER_CONNECTION=1 Set Application Integration to use an https 
connection

SERVER_CONNECTION=0 Set Application Integration to use http 
connection. This is the default if this 
parameter is not passed.

SINGLE_SIGNON Set this to true to use Application Integration 
in a single sign-on environment. The default is 
false if the parameter is not passed.

/L*v C:\temp\AppIntSetup.txt Verbose installation log and specify log 
location.
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To verify your Workplace XT Application Integration installation

1. Start Microsoft Word.

2. From the File menu, click IBM FileNet Workplace XT, click Open Document, and then click Select 
Item. The Login dialog box opens. 

NOTE If you are using SSO and you set the Workplace XT address during installation, the 
action will perform without the Login dialog box. If you did not set the Workplace XT address, 
select IBM FileNet Workplace XT > Set Workplace XT address for SSO to complete the dialog 
(in Office 2003, the IBM FileNet Workplace XT choice displays under the File menu).

3. Log in using any valid account. The available object stores in your environment are displayed.

NOTE  If you didn’t enter the Workplace XT Address information in Step 8 above, enter the 
server name, port number and application name that defines the Workplace XT address. 

• The Server Name is the name of the web server running Workplace XT

• Port is the web server’s assigned port.

• Application is the name of your application, for example, Workplace XT. 

• Check Server uses secure connection (SSL) if you use SSL to encrypt all communication with 
Workplace XT. Do not select this option if you use SSL redirect during login. 

4. Close all dialog boxes and close Microsoft Word.

To uninstall or modify Workplace XT Application Integration

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click IBM FileNet Workplace XT Application Integration 
<version>.

3. Do one of the following:

• Click Remove, and then click Yes to confirm you want to uninstall IBM FileNet Workplace XT 
Application Integration.

• Click Change to access maintenance wizard, and then click Next. You can modify, repair, or 
remove Application Integration using the maintenance wizard.

– Select Modify to add or remove integration with Microsoft applications from your 
previous install. For example, if you have both Microsoft Office and Outlook installed, 
you can remove one of the applications using this option. The Custom Setup dialog 
box appears, where you highlight the option you want to add or remove. Click Next, 
and then click Install. Click Finish to complete the process.

– Select Repair if you want to re-install IBM FileNet Workplace XT Application 
Integration in order to repair installation errors. Click Next. Click Install to start the 
repair process. Click Finish to complete the process.

– Select Remove to remove IBM FileNet Workplace XT Application Integration from your 
system, and then click Next. Click Remove. Once the application is removed from your 
system, click Finish to complete the process.
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To silently uninstall Workplace XT Application Integration

1. Open a command prompt.

2. Enter the following command to uninstall Workplace XT Application Integration:

MsiExec.exe /X{995FB60D-DC35-48BB-B451-681830AEEA9F} /qn
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Install IBM FileNet Workplace XT File Tracker
Install File Tracker if you want to use the Workplace XT file tracking feature without installing 
Application Integration. Installing Workplace XT Application Integration also installs Workplace XT 
File Tracker. Complete the following procedure on each machine that will use Workplace XT File 
Tracker.

NOTE  You cannot collocate Workplace XT File Tracker with clients running Workplace File 
Tracker. 

Verify that the client machine meets the platform requirements documented in the IBM FileNet P8 
Hardware and Software Requirements. To download this guide from the IBM support page, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14.

To install the File Tracker software interactively

1. Log into the client machine using an account that has Administrator privileges. 

2. Log into Workplace XT.

3. Click Tools > Downloads > Download File Tracker..., and do one of the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the FileTrackerXT.exe file locally, and then click Save. Once the file is saved to your hard 
drive, double-click the file to run the installer.

The Welcome Wizard dialog box for Workplace XT File Tracker appears. Another Welcome 
dialog box appears.

4. Click Next.

5. Read the license agreement, and then select I accept the terms to the license agreement, and 
then click Next. If you do not accept the license agreement, you cannot continue with the install. 

6. Do one of the following:

• Click Change if you want to install Workplace XT File Tracker to a different location. Specify the 
location to which you want to install File Tracker, and then click OK. Click Next.

• Click Next to accept the default location.

7. Click Install.

8. After the install is complete, click Finish to complete the setup process.

9. (On Vista using Internet Explorer 7.0 only) Add the Workplace XT URL to the browser security 
tab.

a. In the Internet Explorer 7.0 browser, click Tools > Internet Options. Click the Security tab.

b. Select Trusted Sites, and click the Sites button.

c. Add the Workplace XT URL and click Add.

d. Click OK, and OK again to save changes.
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To install the File Tracker software silently

1. Log onto the client machine using an account that has Administrator privileges and log into 
Workplace XT.

2. Click Tools > Downloads > Download File Tracker...

3. Click Save. In the Save As dialog box, find a location on your machine in which to download and save 
the FileTrackerXT.exe file locally, and then click Save.

4. Open a DOS command window and change the current directory to the one where 
FileTrackerXT.exe resides.

5. Type the following at the command line: 

FileTrackerXT.exe /s /v"/qn <additional msi arguments included in string> 
LICENSE_ACCEPTED=true"

NOTE  Use the /s switch to launch the execution silently and include the /qn switch in the msi string to 
make msi run silently. In addition, be aware of spaces specified between switches in the above 
example. Using the correct spacing ensures a successful silent install.

Refer to the following optional command line values you can also use. Append the values 
within the string containing the msi arguments.

For example, FileTrackerXT.exe /s /v"/qn /L*v C:\temp\FileTrackerSetup.txt 
LICENSE_ACCEPTED=true" 

6. (On Vista using Internet Explorer 7.0 only) Add the Workplace XT URL to the browser security 
tab.

a. In the Internet Explorer 7.0 browser, click Tools > Internet Options. Click the Security tab.

b. Select Trusted Sites, and click the Sites button.

c. Add the Workplace XT URL and click Add.

d. Click OK, and OK again to save changes.

To uninstall IBM FileNet Workplace XT File Tracker

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click IBM FileNet Workplace XT File Tracker <version>.

Command Line Values Settings

/L*v C:\temp\FileTrackerSetup.txt Verbose installation log and specific log 
location.

NOTE  If you intend to specify a log location, 
create the directory before running the silent 
install. If the directory is not created ahead of 
time, the install will fail.
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3. Click Remove, and then click Yes to confirm you want to uninstall IBM FileNet Workplace XT File 
Tracker.

To uninstall IBM FileNet Workplace XT File Tracker silently

1. Open a command prompt.

2. Enter the following command to uninstall IBM FileNet Workplace XT File Tracker:

msiexec.exe /X{8D746557-5081-4A62-951C-14B7F1CD6C52} /qn
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Install Application Integration BCS for Microsoft Office 
(Workplace XT)
Before you can access FileNet P8 documents from within Microsoft® Office 2007 applications or 
Outlook, you must download Application Integration BCS. 

If you do not want users to download Application Integration BCS directly from Workplace XT, you 
can suppress the Download Application Integration BCS for Microsoft® Office 2007 Tools menu 
option. See Customize Workplace XT actions (System Administration > Application Engine and 
Workplace XT Administration > Workplace XT Administration > Customize Workplace XT actions) 
for more information. 

To install Application Integration BCS interactively

1. Log onto the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. From the Workplace XT Tools menu, click Downloads > Download Application Integration BCS. 

4. In the dialog, do one of the following:

• Click Run to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegrationBCS.exe file locally, and then click Save. Once the file is saved to 
your hard drive, double-click the file to run the installer.

If the installer detects that you do not have all the necessary prerequisites installed, it will 
prompt you to perform those installations at this point. When you return to the installer, click 
Next to continue.

A setup preparation dialog appears momentarily, followed by the Welcome dialog box for 
Application Integration BCS. Click Next.

5. If you do not accept the license agreement, you cannot continue with the installation. Accept the 
terms of the license agreement, and click Next.

6. Enter the name of the object store and the object store's preference name. 

The object store name and preference name are defined under Preference Settings in the 
Bootstrap settings site preference. See the IBM FileNet P8 Help topic User Help > Actions, 
preferences, and tools > Site preferences >  Bootstrap preferences. 

7. Enter the Web addresses for the Content Engine server, Workplace XT server, and the help 
server. 

8. Specify a tab label in the IBM ECM Tab Label field. This is the name that will appear on tabs or 
menus for this application.

9. Choose one of the following options: 

– Install for everyone

– Install for just me
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Click Next.

10. Select the location in which you want to install the application. You can click Change to specify a 
different installation path location. 

11. Choose your setup type preference.  Choose Custom to select which Office applications will be 
integrated with IBM FileNet P8.  You can select Word, Excel, Powerpoint, and Outlook. 

12. Click Install and complete the installation process. 

NOTE  InstallShield® provides a list of errors that might occur while you are installing Application 
Integration BCS. The list includes descriptions and resolutions for each error. Access the list in 
Acresso(TM) Software's user documentation Acresso HelpNet > InstallShield 12 Help Library > 
Reference > Errors and Warnings > Setup.exe Return Values and Run-Time Errors (Basic MSI 
and InstallScript MSI Projects).

http://helpnet.acresso.com/robo/projects/installshield12helplib/IHelpSetup_EXEErrors.htm

To install the Application Integration BCS software silently

1. Log onto the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. Click Tools > Downloads > Download Application Integration BCS....

4. Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegrationBCS.exe file locally, and then click Save.

5. Open a DOS command window and change the current directory to the one where 
ApplicationIntegrationBCS.exe resides.

6. Type (do not copy and paste) the following at the command line:

ApplicationIntegrationBCS.exe /s /v"/qn <additional arguments included in string> 
LICENSE_ACCEPTED=true"

Use the /s switch and include the /qn switch to launch the install silently.

Refer to the following optional command line values you can also use. Append the values within the string 
containing the arguments.

NOTE  When there are spaces in the property values, the entire value must be surrounded by 
quotes (\”).  The quote must be prepended with a slash because the entire value of the /v 
argument, which includes the property values, is also surrounded by quotes.

For example:

ApplicationIntegrationBCS.exe  /s /v"/qn /L*v C:\AppIntSetup.txt CEURL=\"http://CE 
Server Name:port/wsi/FNCEWS40MTOM/\" WORKPLACEXTURL=\"http://Workplace XT Server 
Name:port/WorkplaceXT/\" HELPURL=\"http://Help Server Name:port/ecm_help\" 
PREFERENCESNAME=PreferenceName PREFERENCESOBJECTSTORE=\"Preference ObjectStore\" 
LICENSE_ACCEPTED=true"
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Command Line Values Settings

CEURL The URL of the CE server, for example:

http://Server Name:port/wsi/
FNCEWS40MTOM/

WORKPLACEXTURL The URL of the Workplace XT server, for 
example: 

http://Server Name:port/WorkplaceXT/

HELPURL The URL of the help server.

PREFERENCESNAME The name of the preferences file on the 
Workplace XT server to use.

PREFERENCESOBJECTSTORE The name of the object store that contains the 
preferences file.

LICENSE_ACCEPTED Required to be passed when installing 
silently.  Value=true.

ADDLOCAL Used to control what add ins are installed.  
Omit to add all of them.  Other possible 
values:

• Excel

• Outlook

• Powerpoint

• Word

(Can be combined, separated by commas)

SAVE_SETTINGS_FOR_ALL Used to control if add ins are installed for 
all users of the computer, or just the 
current user.  Can be omitted to use the 
default.

Values:

1 - for all users

2 - current user (default)

IBMECMTAB Used to control the text of the tab in the 
office ribbon bar.  If omitted, the default 
value used is "IBM ECM"

/L*v C:\temp\AppIntBCSSetup.txt Verbose installation log and specify log 
location.
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To upgrade Application Integration BCS interactively

1. Log onto the upgrade Workplace XT client machine using an account that has Administrator 
privileges.

2. Close all Office applications.

3. Log in to Workplace XT.

4. From the Workplace XT Tools menu, click Downloads > Download Application Integration BCS. 

5. In the dialog, do one of the following:

• Click Run to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegrationBCS.exe file locally, and then click Save. Once the file is saved to 
your hard drive, double-click the file to run the installer.

A setup preparation dialog appears momentarily, followed by the message "This setup will 
perform an upgrade of IBM FileNet Application Integration BCS.  Do you want to continue?" Y 
N.

6. Choose Yes to begin the upgrade process.

7. Click Next on the "Resuming the InstallShield Wizard..." panel.

8. Click Finish.

To upgrade Application Integration BCS silently

1. Log onto the client machine using an account that has Administrator privileges.

2. Log in to Workplace XT.

3. Click Tools > Downloads > Download Application Integration BCS....

4. Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegrationBCS.exe file locally, and then click Save.

5. Open a DOS command window and change the current directory to the one where 
ApplicationIntegrationBCS.exe resides.

6. Type (do not copy and paste) the following at the command line:

ApplicationIntegrationBCS.exe  /s /v"/qn /L*v C:\AppIntSetup.txt"

Use the /s switch and include the /qn switch to launch the upgrade silently.

To uninstall or modify  Application Integration BCS

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click IBM FileNet Workplace XT Application Integration 
BCS <version>.

3. Do one of the following:
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• Click Remove, and then click Yes to confirm you want to uninstall IBM FileNet Workplace XT 
Application Integration BCS.

• Click Change to access maintenance wizard, and then click Next. You can modify, repair, or 
remove Application Integration BCS using the maintenance wizard.

– Select Modify to add or remove integration with Microsoft applications from your 
previous install. For example, if you have both Microsoft Office and Outlook installed, 
you can remove one of the applications using this option. The Custom Setup dialog 
box appears, where you highlight the option you want to add or remove. Click Next, 
and then click Install. Click Finish to complete the process.

– Select Repair if you want to re-install IBM FileNet Workplace XT Application 
Integration BCS in order to repair installation errors. Click Next. Click Install to start 
the repair process. Click Finish to complete the process.

– Select Remove to remove IBM FileNet Workplace XT Application Integration BCS from 
your system, and then click Next. Click Remove. Once the application is removed from 
your system, click Finish to complete the process.

To silently uninstall Workplace XT Application Integration BCS

1. Open a command prompt.

2. Enter the following command to uninstall Workplace XT Application Integration BCS and create 
a log file called AppIntBCSUninstall.txt:

msiexec.exe /X {6987BFD1-995E-4D8E-AD3A-8F3292EF1C09} /qn /L*v 
C:\temp\AppIntBCSUninstall.txt

Configuration Options
The configuration.ini file is similar to the bootstrap properties. The file contains Web 
addresses for the Content Engine, Workplace XT, and documentation servers, and the location of 
the site preferences file defined in the Bootstrap settings site preference. For details, see the IBM 
FileNet P8 Help topic User Help > Actions, preferences, and tools > Site preferences >  Bootstrap 
preferences. This information cannot be stored in a site preference file because it is needed prior 
to users logging into Application Integration BCS. You can update this file when you modify the 
Web addresses and site preferences file location, and then send the updated information to each 
client machine.

The configuration.ini file is created on the system in which Application Integration BCS is 
installed. It resides in either of the locations included in the table below. You determine the 
location when you choose to make Application Integration BCS available to all users with an 
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account on the system or to the user logged into the current system during the installation 
process.

Configuration.ini settings
Use the following table to identify the settings and their definitions.

Location of configuration.ini file Created for...

\Documents and Settings\All 
Users\Application 
Data\IBM\Application Integration 
BCS

All users with an account on the system.

\Documents and 
Settings\[Username]\Application 
Data\IBM\Application Integration 
BCS

Current user logged into the system.

Settings Definitions

PreferencesObjectStore This name and preference name identify where the site 
preferences file is located. It is defined in the Bootstrap 
settings site preference.

PreferencesName This name and object store name identify where the site 
preferences file is located. It is defined in the Bootstrap 
settings site preference.

CEURL This Web address Identifies the object stores accessed by 
users.
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WorkplaceXTURL This Web address is used when you include links to FileNet 
P8 documents from an integrated application.

HelpURL This Web address used for accessing the help 
documentation supporting Application Integration BCS.

IBMECMTabLabel This name appears on the IBM ECM tab on the Microsoft 
Office 2007 Ribbon and on the IBM ECM menu and option 
in Outlook.

LoggingLevel The following settings are used to control the errors that 
are logged in the Microsoft Windows event log:

• NONE - No errors logged

• ERROR - Only error messages are logged

• WARNING - Warning and error messages are logged

• no value (default) – All messages are logged

ShowStackTrace This controls whether the stack trace is available on error 
message dialog boxes. Values (case sensitive) are true or 
false (default).

Settings Definitions
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Deploy multiple IBM FileNet Workplace XT instances
This topic covers deployment of multiple instances of Workplace XT on a single application server. 
Each deployment of Workplace XT must use the same Content Engine, Process Engine, and 
connection point. Each deployment of Workplace XT may use different Site Preference files and 
may provide access to different object stores.

NOTES 

• The procedure below assumes that you have already installed Workplace XT and deployed 
one instance of the Workplace XT application. You may or may not have signed in and 
configured your bootstrap preferences.

• For more information on how to deploy and manage multiple identical applications, see your 
application server documentation. 

• For WebLogic, deployment using a flat directory is not recommended when there will be 
multiple deployments.

To deploy a second instance of the Workplace XT application

1. Copy the Workplace XT configuration folder.

On the Workplace XT server, make a copy (WebClient2) of the Workplace XT configuration 
folder found at:

install_path/FileNet/Config/WebClient

and place it in the same directory to create install_path/FileNet/Config/WebClient2

2. Copy the deploy folder.

On the Workplace XT server, make a copy (deploy2) of the Workplace XT deploy folder found 
at:

install_path/FileNet/WebClient/deploy

and place it in the same directory to create install_path/FileNet/WebClient/deploy2

3. Delete the .war file and the .ear file from the deploy2 directory.

4. In the install_path/FileNet/WebClient/deploy2 directory, edit the 
create_web_client_war.bat or .sh file.

a. Make a backup of the file.

b. Change the following lines:

cd /D  "%WEB_HOME%\WorkplaceXT"

"%WEB_HOME%\_AEjvm\bin\jar" -cf "%WEB_HOME%\deploy\web_client.war" author 
containerSecured css download eprocess FnJavaV1Files images include is js 
operations portlets properties redirect regions scripts select UI-INF utils 
WEB-INF wizards *.jsp

rem Add P8 eForms if installed.
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if exist "%WEB_HOME%\deploy\eforms_add_to_war.bat" call 
"%WEB_HOME%\deploy\eforms_add_to_war.bat"

to this:

cd /D  "%WEB_HOME%\WorkplaceXT"

"%WEB_HOME%\_AEjvm\bin\jar" -cf "%WEB_HOME%\deploy2\web_client2.war" author 
containerSecured css download eprocess FnJavaV1Files images include is js 
operations portlets properties redirect regions scripts select UI-INF utils 
WEB-INF wizards *.jsp

rem Add P8 eForms if installed.

if exist "%WEB_HOME%\deploy2\eforms_add_to_war.bat" call 
"%WEB_HOME%\deploy2\eforms_add_to_war.bat"

to include the modified folder name and the new name for the WAR file, such as 
web_client2.war.

5. If you want to deploy as an EAR file, modify the create_web_client_ear.bat or .sh file in 
the install_path/FileNet/WebClient/deploy2 directory to point to the modified folder 
names and to rename the EAR file.

a. Make a backup of the create_web_client_ear.bat or .sh file.

b. Edit the create_ear.bat or .sh file to change these lines:

cd /D  "%WEB_HOME%\deploy"
"%WEB_HOME%\_AEjvm\bin\jar" -cvf "%WEB_HOME%\deploy\web_client.ear" META-INF 
*.war

to this:

cd /D  "%WEB_HOME%\deploy2"
"%WEB_HOME%\_AEjvm\bin\jar" -cvf "%WEB_HOME%\deploy2\web_client2.ear" META-
INF *.war

6. In the Workplace XT install directory, edit the web.xml file.

a. In FileNet\WebClient\WorkplaceXT\WEB-INF, rename web.xml to web.xml.1.

b. Create a copy of web.xml.1, and name it web.xml.

c. In the new web.xml, change the following parameter value:

<param-name>configurationDirectory</param-name> 
<param-value>C:/Program Files/FileNet/Config/WebClient</param-value> 

to set the path to the new configuration folder copy you created in Step 1, for example, 
<install_path>/FileNet/Config/WebClient2

NOTE  On Windows, use double back slash (\\) in place of the forward slash in the 
configurationDirectory.

d. (For deployments using the EAR file only) Change the value of the context root to the 
custom name you have chosen for the new application instance, for example, Workplace 
XT2.
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7. Recreate the WAR file by running create_web_client_war.bat or .sh.

8. (For EAR file deployments only) Recreate the EAR file by running 
create_web_client_ear.bat or .sh.

9. Rename the web.xml files.

a. Rename the web.xml file (that applies to the second instance) to web.xml.2.

b. Rename the original file, now called web.xml.1, back to web.xml.

NOTE  The original web.xml file is for the original application instance, and web.xml.2 is for 
the new instance. If you need to do further configuration for either instance, you must rename 
the appropriate version of the file to “web.xml” during the configuration.

10. Clean up the bootstrap.properties file.

NOTE  If you haven’t yet signed in to the Workplace XT application as part of your first 
Workplace XT installation there is no need to clean up the file. 

When you first sign in to Workplace XT certain values in the bootstrap.properties file, 
such as the name and location of the site preferences file, are set. To use different settings for 
your new Workplace XT application you must remove the existing entries from the copied file. 

The bootstrap.properties file is located in:

install_path/FileNet/Config/WebClient2 

Edit the bootstrap.properties file:

• Remove the value entered for the prefName setting - This entry contains the name of the site 
preferences file stored on the object store.

• Remove the value entered for the objectStoreId - This entry contains the object store name 
where your site preferences will be stored.

• Remove or edit any of the other values as needed.

11. In the relevant configuration files in the new FileNet/Config/WebClient2 directory, remove 
any comments and custom changes that should not apply to the second Workplace XT instance. 

NOTE  If you haven’t yet signed in to the Workplace XT application as part of your first 
Workplace XT installation there is no need to clean up the files.

12. Deploy the second Workplace XT instance.

Follow the application server specific procedures below to deploy your second instance of 
Workplace XT using a unique name (WorkplaceXT2 in the procedure below). 

When deploying the second instance, use the newly created web_client2.war or 
web_client2.ear file (depending on which method you choose) to deploy the application:

deploy2/web_client2.war or deploy2/web_client2.ear 

• WebSphere - See “Deploy IBM FileNet Workplace XT (WebSphere)” on page 62. 

CAUTION  Deploy the WAR file with a different Context Root name, WorkplaceXT2.

• WebLogic - See “Deploy IBM FileNet Workplace XT (WebLogic)” on page 65. 
IBM FILENET WORKPLACE XT INSTALLATION AND UPGRADE GUIDE



 Deploy multiple IBM FileNet Workplace XT instances
To deploy a second instance of the Workplace XT application

101
CAUTION  The new application will deploy using the name specified in the context root or 
the name of the WAR file. 

• JBoss - See “Deploy IBM FileNet Workplace XT (JBoss)” on page 67. 

CAUTION  Deploy the WAR file with a different Context Root name, WorkplaceXT2.

13. Sign in and set bootstrap preferences for the new application.

Use the following URL when signing in to set the bootstrap preferences for your new 
Workplace XT instance.

http://WorkplaceXTServerName:port#/WorkplaceXT2

NOTE  You must specify a unique name for the Preference name for each deployment. For 
details, see “Set IBM FileNet Workplace XT bootstrap preferences” on page 71.
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Upgrade tasks

To upgrade IBM FileNet Workplace XT

1. Upgrade the IBM FileNet XT software. Perform Task 1 on page 103.

2. Install software updates. Perform Task 2 on page 107.

3. Update the Content Engine Client files on the Workplace XT server. Perform Task 3 on page 108.

4. Update the Process Engine Client files on the Workplace XT server. Perform Task 4 on page 111.

5. Deploy IBM FileNet Workplace XT according to your application server type:

• Websphere: Task 5a on page 115

• WebLogic: Task 5b on page 118

• JBoss: Task 5c on page 120

6. Upgrade multiple instances of IBM FileNet Workplace XT. Perform Task 6 on page 123.
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Task 1: Upgrade IBM FileNet Workplace XT
This task includes IBM FileNet Workplace XT upgrade instructions for all supported application 
servers, for UNIX and Windows platforms. The upgrade installer recreates the IBM FileNet 
Workplace XT folder structure and files needed for Workplace XT. After upgrading the files, and 
any necessary updates, you must also re-deploy the Workplace XT application. 

To enable screen reader assistive technology for the upgrade tool

If you plan to use JAWS screen reader for the upgrade tool, you must perform the following tasks 
before you begin the upgrade:

1. Ensure that the Sun Java JRE 1.5.0 or 1.5.x is installed on the system where you will be 
performing the install. 

2. Install the Java Access Bridge (available at http://java.sun.com).

3. Start the JAWS screen reader.

To upgrade the IBM FileNet Workplace XT software

1. Log in to the application server:

UNIX

Log in as a user with write access to the /bin directory and read, write, and execute access to 
the directory where you plan to install IBM FileNet Workplace XT. The user should also be a 
member of the bin group.

Windows

Log in as a member of the local Administrators group or a user with equivalent permissions.

2. From Process Task Manager, stop Component Manager (if running), then exit the Process Task 
Manager application.

3. (Windows only) From the Windows Services console, stop the Process WP XT Services 
Manager service.

4. (Windows only) Using the Windows Task Manager, verify that no javaw.exe processes are 
running.

NOTE  If the applications in the preceding steps stopped correctly, no Workplace XT-related 
javaw.exe processes should be running. If needed, use Windows Task Manager or some other 
process management tool to stop all javaw.exe processes that are in the directory path 
install_path\_WCjvm\bin.

5. Back up, undeploy, and remove the Workplace XT (web_client) web application from the J2EE 
application server.

WebSphere

a. Back up the deployed Workplace directory:
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WAS_HOME/profiles/default/installedApps/node_name/WorkplaceXT.ear/
web_client.war

b. Stop the Workplace XT application from the WebSphere administration console.

c. Uninstall the Workplace XT application from Enterprise Applications.

d. Save the changes and stop the WebSphere server.

e. Delete the temporary Workplace XT directory (default: WorkplaceXT) from: 

WAS_HOME/profiles/default/temp/node_name/instance/

WebLogic

a. From the WebLogic administration console stop the Workplace XT Web Application Module.

b. Make a backup copy of the Workplace XT folder: 

– install_path/WorkplaceXT

c. Delete the Workplace XT Web Application Module.

d. Stop the WebLogic server.

JBoss 4.0.x

a. Stop the JBoss server. 

b. Back up the deployed Workplace XT application: 

JBOSS_HOME/server/<server_name>/deploy/application_name.war or .ear 

c. Delete the Workplace XT application from the deployed location. 

d. Clear out all files and folders within the following temp directories:

JBoss_home/server/server_name/tmp/deploy
JBoss_home/server/server_name/work/jboss.web/localhost

6. (Optional) Copy existing configuration files.

If you have made custom changes to your configuration files in the deployed location, do the 
following before you upgrade the existing Workplace XT installation.

Copy the following files:

• WcmApiConfig.properties

• web.xml

from the /WEB-INF folder in the backed-up Workplace XT directory created in the previous 
step to the following directory:

install_path/WorkplaceXT/WEB-INF/

7. Start the upgrade process in one of the following ways, depending on whether you want to 
upgrade in interactive or silent mode:

• To upgrade IBM FileNet Workplace XT interactively:
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i. Access the IBM FileNet Workplace XT 1.1.3.0 installation software package.

ii. Launch the appropriate Setup program (WorkplaceXT-1.1.3.0-
operating_system.bin/.exe) and follow the prompts in the wizard screens. The installer 
detects and copies settings from the previous Workplace XT installation.

iii. Continue with Step 8 on page 105 below.

• To upgrade IBM FileNet Workplace XT silently:

i. Access the IBM FileNet Workplace XT installation software package, and copy the 
XT_silent_upgrade.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the values to reflect the appropriate 
responses for your installation. 

NOTE  Even if you accept all defaults in the XT_silent_upgrade.txt file, you must 
edit the file to accept the license agreement (-V licenseAccepted="true").

iii. From a command prompt, navigate to and run the installer:

UNIX

./WorkplaceXT-1.1.3.0-<operating_system>.bin -options 
“path_to_edited_input_file/XT_silent_upgrade.txt” -silent 

Windows

WorkplaceXT-1.1.3.0-Win.exe -options 
“path_to_edited_input_file\XT_silent_upgrade.txt” -silent

8. When the upgrade program is complete, view the web_client_install_log_1.1.3.0.txt 
file located in: install_path/FileNet/WebClient .

Verify that no errors or failures were logged. Correct any errors before you proceed.

9. (optional) Update files to support user tokens for Workplace XT.

NOTE If you are upgrading Workplace XT to 1.1.3, but your Content Engine is still at 4.0.x, the 
following step does not apply.

WebSphere

a. Copy the authentication-websphere.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

WAS_home/AppServer/lib/ext

b. Copy the log4j-1.2.13.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

WAS_home/AppServer/lib/ext

WebLogic 
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a. Copy the authentication-weblogic.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

WL_home/server/lib/mbeantypes

b. Copy the log4j-1.2.13.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/WEB-INF/lib

to here:

WL_home/server/lib/mbeantypes

JBoss

a. Copy the authentication-utils.jar file from here:

install_path/FileNet/WebClient/WorkplaceXT/authenticationFiles

to here:

JBOSS_home/server/server_name/lib

10. Continue with the task “Install the latest Content Engine Client files on Workplace XT servers” on 
page 33.
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Task 2: Install IBM FileNet Workplace XT software 
updates
Install any service packs, fix packs, and interim fixes required for Workplace XT.

To install the Workplace XT software updates

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service 
representative or see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 14.

2. Open the readmes for the software updates and perform the installation procedures provided.

3. Install the latest Content Engine and Process Engine client file updates, as described in the 
subsequent tasks.
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Task 3: Install the latest Content Engine Client files on 
Workplace XT servers
CAUTION  If you are performing a staged upgrade, and are upgrading Workplace XT before you 
upgrade the Content Engine server to 4.5, do not perform this task. You will return to update the 
Content Engine Client files after you upgrade Content Engine to version 4.5.

Install the Content Engine Client files and any updates that are available.

To install the Content Engine Client files

Refer to the appropriate information from your installation worksheet while performing the following 
steps.

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service 
representative.

2. On the machine where Workplace XT is installed, log on as any user who has the following 
permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Workplace XT is installed.

• Execute permission on the Content Engine Client install software.

3. (For updates only) Verify that there is a current backup of Workplace XT.

4. Copy the Content Engine Client install software from the Content Engine installation software to 
the temporary directory. The version of the install software must match the version of Content 
Engine. 

5. Expand the (TAR or ZIP) Content Engine Client install software within the temporary directory.

6. Close all instances of Workplace XT and any other Application Engine client applications. From 
the application server administrative console, stop and un-deploy Workplace XT.

WebSphere   Stop and un-deploy Workplace XT.

WebLogic   Stop and un-deploy Workplace XT.

JBoss   Run the shutdown command.

7. (WebLogic only) Manually delete the following application server cache directories, substituting 
your domain name  in place of mydomain:

WebLogic UNIX

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/tmp/_WL_user/
web_client

/opt/ bea/user_projects/domains/mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/cache/
EJBCompilerCache
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WebLogic Windows

C:\bea\user_projects\domains\mydomain\servers\AdminServer\tmp\_WL_user\web_
client

C:\bea\user_projects\domains\mydomain\servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\servers\AdminServer\cache\EJBCompiler
Cache

8. Start the Content Engine client install process.

• To install the Content Engine client interactively:

i. Access the IBM FileNet Content Engine client update software.

ii. Run one of the commands in the table below, CE_version is the version of Content Engine 
you intend to run, for example, 4.5.0..

iii. Complete the installation program wizard. 

You can specify on the installer which applications you want to update. If the installer 
does not automatically detect Workplace XT, select it on the appropriate panel. 

You can also choose to have the installer create the deployment file, or create the file 
later. If you have additional configuration to perform, you can defer the file creation to 
avoid running multiple processes to create the same file.

• To install the Content Engine client files silently:

i. Make a backup copy of the input file:

CEClient_silent_install.txt

ii. Open the silent input file in a text editor. Follow the instructions in the silent input file to 
edit the file to reflect the appropriate responses for your update.

iii. Navigate to the path containing the Content Engine Client installation program, and run 
one of the commands in the following table to perform the silent install, where:

CE_version is the version of Content Engine you intend to run, for example, 4.5.0.

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN
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path is the path that contains the installation program.

9. Install Process Engine Client updates. Do “Install the latest Process Engine Client files on 
Workplace XT servers” on page 111.

Operating 
System

Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/  
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/ 
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\ 
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/
CEClient.zLinux/CEClient_silent_install.txt -i silent
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Task 4: Install the latest Process Engine Client files on 
Workplace XT servers
IMPORTANT  If you are performing a staged upgrade, and are upgrading Workplace XT before you 
upgrade the Process Engine server to version 4.5, do not perform this task. You will return to 
update the Process Engine Client files after you upgrade Process Engine to version 4.5.

Install any Process Engine Client files or updates that are available. These steps apply to 
WebSphere, WebLogic, and JBoss (except where noted). Perform the following steps on all 
Workplace XT servers.

To install the Process Engine Client files

1. To download the latest software updates, and to determine which of these updates might be 
required for use with other components and expansion products, contact your service 
representative.

2. Log on to the server as a user who has permission to install software and read and write 
permission to a local temp directory. 

3. (Update installations only) Ensure that there is a backup of the deployed web application 
directory.

4. Download and expand the appropriate tar or zip file for Process Engine Client installation to the 
server and extract the contents to the local temp directory.

5. From Process Task Manager, stop the Component Manager(s) (if running), then exit the Process 
Task Manager application. 

6. (Update installations only) If you wish to retain your existing configurations, copy the following 
configuration files from the backup copy of your deployed application to the /WEB-INF folder in 
the installed directory on your application server, overwriting the existing installed files.

The backup of these files is to ensure the files are still available in case there is any reason to 
go back to the previous versions. When redeploying after installing the fix pack, any custom 
settings will be added back to the deployed working directory.

From the /WEB-INF folder in the backed-up Workplace XT directory created in Step 3 on page 
111 above, copy these files:

WcmApiConfig.properties

web.xml

to here

<XT_install_path>/WorkplaceXT/WEB-INF/ 

NOTE  You must do this before you apply the fix pack to the existing installation.

7. (Update installations only) (WebSphere and WebLogic Only) Stop and undeploy any instances 
of Workplace XT. 

8. (Update installations only) (JBoss Only) Run the shutdown command.
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9. (Update installations only) Manually delete the web application temporary directories associated 
with Workplace XT.

10. (Update installations only) (JBoss only) Delete the deployed Web application directory, or WAR 
or EAR file.

11. Start the Process Engine Client install process.

– To install the Process Engine Client interactively:

i. Access the IBM FileNet Process Engine Client update software.

Launch the appropriate install program, as shown in the following table:

ii. Complete the installer panels and run the installation.

You can specify on the installer which applications you want to update. If the installer 
does not automatically detect Workplace XT, select it on the appropriate panel. 

If you plan to use the ECM Widgets component, or want to use Process Engine REST 
services directly, select Add the REST service on that panel.

You can also choose whether to have the installer create the deployment file for you. If 
you have additional configuration to perform, you can defer the file creation to avoid 
running multiple processes to create the same file.

– To install the Process Engine Client silently:

i. Access the IBM FileNet Process Engine Client update software package, and copy the 
PEClient_silent_input.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the file to reflect the appropriate 
responses for your update. 

Change the Variable_CheckboxXT line to the following:

-V Variable_CheckboxXT="true"

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN

Linux P8PE-CLIENT-4.5.0-LINUX.BIN

Solaris P8PE-CLIENT-4.5.0-SOL.BIN

Windows P8PE-CLIENT-4.5.0-WIN.EXE

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN
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iii. Run the PE Client installer with one of the following commands::

12. (For upgrades from PE 4.0.x to 4.5 only) Add required JAR files to the Component Manager 
library.

a. Launch the Process Task Manager by running one of the following command files from the 
install_path/FileNet/WebClient/Router directory, depending on your operating 
system:

UNIX

routercmd.sh

Windows

routercmd.bat

b. In the Process Task Manager console, under Workplace XT, Component manager node, 
select your connection point.

c. Stop the connection point instance.

d. Click the Required libraries tab.

e. Click Add, and browse to /Router/lib.

f. Select the following files to add:

ContentExtendedOps.jar

smtp.jar

Operating 
System

Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN -options 
"PEClient_silent_install.txt" -silent

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN -options 
"PEClient_silent_install.txt" -silent

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN -options 
"PEClient_silent_install.txt" -silent

Linux P8PE-CLIENT-4.5.0-LINUX.BIN -options 
"PEClient_silent_install.txt" -silent

Solaris P8PE-CLIENT-4.5.0-SOL.BIN -options 
"PEClient_silent_install.txt" -silent

Windows P8PE-CLIENT-4.5.0-WIN.EXE -options 
"PEClient_silent_install.txt" -silent

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN -options 
"PEClient_silent_install.txt" -silent
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(Optional) To configure the Process Engine REST services connection

If you plan to use the ECM Widgets component, or want to use Process Engine REST services 
directly, configure the Process Engine Rest service connection by editing the 
P8BPMRESTConfig.xml file.

1. Navigate to install_path/FileNet/WebClient/WorkplaceXT/WEB-INF.

2. Open P8BPMRESTConfig.xml for editing.

3. Locate the entries for the Content Engine Bootstrap URI and the connection point, near the top 
of the file:

<perest:filenet.pe.bootstrap.ceuri value="iiop://cm-peru:2809/FileNet/Engine"/>
<perest:connection.point value="RESTCP"/>

4. Replace these entries with the values for your environment:

– Replace my_server:2809 with your Content Engine server name and port number.

– Replace RESTCP with the name of your connection point.

5. Save your changes and close the file.

Continue with deploying Workplace XT. See the appropriate task according to your application 
server type:

• “Deploy IBM FileNet Workplace XT (WebSphere)” on page 115

• “Deploy IBM FileNet Workplace XT (WebLogic)” on page 118

• “Deploy IBM FileNet Workplace XT (JBoss)” on page 120
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Task 5a: Deploy IBM FileNet Workplace XT 
(WebSphere)
This topic covers the deployment and start of the IBM FileNet Workplace XT application on 
WebSphere. 

To recreate the WAR and EAR files

NOTE  If you are using a WAR file or EAR file for deployment, you must recreate the WAR file or 
WAR and EAR files and redeploy the application each time you make changes to files in the
/FileNet/WebClient/WorkplaceXT directory. If you chose not to have the Content Engine or 
Process Engine Client installers create your deployment file, or if you made changes to web.xml 
for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists. To recreate the 
WAR file, run one of the following commands:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and 
web_client.ear exist. To recreate the EAR file, first recreate the WAR file, and then run the 
following command to recreate the EAR file:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_ear.bat

To deploy Workplace XT

1. From the WebSphere administrative console, navigate to the dialog for installing a new 
application. 

2. Select the file to deploy:

• (If the administrative console is running locally) Select Local file system and enter or browse to the 
location of the .war or .ear file created by the setup program (see below for the default path). Do 
not enter the machine name.

• (If the administrative console is remote) Select Remote file system and enter the fully-qualified 
path to the .war or .ear file. Do not enter the machine name.

The default path is install_path/FileNet/WebClient/deploy

3. If you are deploying a WAR file, enter the context root: 

Enter WorkplaceXT and click Next to proceed to deploying a new application.
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NOTE  The context root is the name of the application you log in to using the web interface, 
such as http://WorkplaceXTServerName:port#/Context_Root. Do not include any spaces in 
the context root.

4. Complete the dialog boxes for installing a new application, using the following settings:

NOTE  For any settings not specified here, accept the defaults.

• Show me all installation options and parameters: selected

• Application name: Workplace XT, or the name you chose to call the application.

• WebServer: The server you are planning to use. Verify that your application name is selected and 
associated with the correct WebServer.

• Map virtual hosts for Web modules: select WorkplaceXT or the name you chose to call the 
appplication

5. Finish the install and save it to the master configuration.

NOTE  Do Step 6 to Step 8 for each specific web application deployment only. Do not change 
the similar settings for the entire application server.

6. Configure the Class loader setting so that the parent class loader is loaded last. 

7. Update the polling interval to a number appropriate for your environment.

8. For the Workplace XT (or the name of your application) web module, configure the Class loader 
setting so that the parent class loader is loaded last.

9. Save your changes to the master configuration.

10. Navigate to Enterprise Applications > Workplace > Map security roles to users/groups, and 
verify that the All Authenticated column is checked for the "All Authenticated" role, and that the 
Everyone? column is checked for the “Everyone” role.

11. Set permissions for the user running the application server.

If the local user who will be running the application server is different from the user who 
installed IBM FileNet Workplace XT, you must give the user read/write permissions on the 
following (default) folders:

WAS_HOME/profiles/default/installedApps/node_name/WorkplaceXT.ear/
web_client.war

install_path/FileNet/WebClient

12. (Windows only) From the Windows Services Console, restart the Process Workplace XT 
Services Manager service. 

13. Restart Process Task Manager and Component Manager.
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14. Exit the Process Task Manager application.

15. Start Workplace XT from the administrative console.

NOTE To troubleshoot the deployment, check the following log:

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log

NOTE  Each new version of Workplace XT can add new actions or modify existing actions. When 
you have completed the upgrade and deployment steps, review the new and modified actions in 
your upgraded Workplace XT environment and apply whatever access roles are appropriate for 
your site. For details, see the IBM FileNet Workplace XT help topic User Help > Actions, preferences, 
and tools > Site preferences > Actions preferences.
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Task 5b: Deploy IBM FileNet Workplace XT (WebLogic)
This topic covers the deployment of your IBM FileNet Workplace XT application on WebLogic.

To recreate the WAR and EAR files (optional)

NOTE  If you are using a WAR file or EAR file for deployment, you must recreate the WAR file or 
WAR and EAR files and redeploy the application each time you make changes to files in the
/FileNet/WebClient/WorkplaceXT directory. If you chose not to have the Content Engine or 
Process Engine Client installers create your deployment file, or if you made changes to web.xml 
for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists.To recreate the 
WAR file, run one of the following commands:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and 
web_client.ear exist. To recreate the EAR file, first recreate the WAR file, and then run the 
following command to recreate the EAR file:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_ear.bat

To rename the WAR file (optional)

NOTE  This step is optional. Perform this step only if you are using a WAR file for deployment, and 
you want to use “Workplace XT” or a custom name for the context root of the application. The 
context root is part of the URI that end users type to access Workplace XT. 

By default, when you deploy from a WAR file, the context root is the first part of the WAR filename. 
For example, the default web_client.war will generate a context root of http://server_name:port#/
webclient. If you want to use http://server_name:port#/custom_name, you must rename 
web_client.war to custom_name.war.

1. Use the rename command to rename the WAR file. Enter the command without the line break.

UNIX

rename install_path/FileNet/WebClient/deploy/web_client.war  
     install_path/FileNet/WebClient/deploy/custom_name.war 

Windows

rename install_path\FileNet\WebClient\deploy\web_client.war  
     install_path\FileNet\WebClient\deploy\custom_name.war 
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To deploy IBM FileNet Workplace XT (WebLogic 9.2)

1. Use the WebLogic Administration Console to deploy Workplace XT. 

You can deploy the application in one of the following ways:

• To deploy from an exploded folder, choose the Workplace XT folder in install_path/
FileNet/WebClient 

• To deploy from a WAR or EAR file, choose the web_client.war or web_client.ear file in 
install_path/FileNet/WebClient /deploy 

2. Accept the defaults for the deployment, except for the name for the deployment. Use “Workplace 
XT” or the custom name you have chosen instead of “web_client”.

3. Finish and save your changes.

NOTE  To verify that the deployment was successful, expand Web Applications. The web 
application name you specified for Workplace XT will be listed.

4. After IBM FileNet Workplace XT is deployed, start the application from the WebLogic 
Administration Console.

5. (Windows only) From the Windows Services Console, restart the Process Workplace XT 
Services Manager service. 

6. Restart Process Task Manager and Component Manager. 

7. Exit the Process Task Manager application.

NOTE To troubleshoot the deployment, check the following log:

WLS_install_path/user_projects/domains/domain_name/servers/server_name/logs/
server_name.log

NOTE  Each new version of Workplace XT can add new actions or modify existing actions. When 
you have completed the upgrade and deployment steps, review the new and modified actions in 
your upgraded Workplace XT environment and apply whatever access roles are appropriate for 
your site. For details, see the IBM FileNet Workplace XT help topic User Help > Actions, preferences, 
and tools > Site preferences > Actions preferences.
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Task 5c: Deploy IBM FileNet Workplace XT (JBoss)
This topic covers the deployment and start of Workplace XT on JBoss.

To recreate the WAR or EAR files (optional)

NOTE  If you are using a WAR file or EAR file for deployment, you must recreate the WAR file or 
WAR and EAR files and redeploy the application each time you make changes to files in the
install_path/FileNet/WebClient/WorkplaceXT directory. If you chose not to have the 
Content Engine or Process Engine Client installers create your deployment file, or if you made 
changes to web.xml for SSO support, or any other edits, recreate the WAR and EAR files. 

1. If you will be deploying from a WAR file, verify that web_client.war exists. To recreate the 
WAR file, run one of the following commands:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_war.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_war.bat

2. If you will be deploying from an EAR file, verify that both web_client.war and 
web_client.ear exist. To recreate the EAR file, first recreate the WAR file, and then run the 
following command to recreate the EAR file:

UNIX

install_path/FileNet/WebClient/deploy/create_web_client_ear.sh

Windows

install_path\FileNet\WebClient\deploy\create_web_client_ear.bat

To deploy  as “Workplace XT” or custom name using a WAR file (optional)

NOTE  This step is optional. Perform this step only if you are using a WAR file for deployment, and 
you want to use “Workplace XT” or a custom name for the context root of the application. The 
context root is part of the URI that end users type to access Workplace XT. 

By default, when you deploy from a WAR file, the context root is the first part of the WAR filename. 
For example, the default web_client.war will generate a context root of http://
<server_name>:<port#>/webclient. If you want to use http://server_name:port#/custom_name, you 
must rename web_client.war to custom_name.war.

1. Use the rename command to rename the WAR file. Enter the command without the line break.

UNIX

rename install_path/FileNet/WebClient/deploy/web_client.war  
     install_path/FileNet/WebClient/deploy/custom_name.war 

Windows

rename install_path\FileNet\WebClient\deploy\web_client.war  
     install_path\FileNet\WebClient\deploy\custom_name.war 
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CAUTION  You must rename the WAR file every time you regenerate it. The 
create_web_client_war.sh/.bat script will by default create a file with the name 
web_client.war.

To deploy Workplace XT

1. Stop JBoss, if it is running.

2. Deploy Workplace XT

• (For exploded directory deployment only)

i. On the JBoss server, copy the WorkplaceXT folder from: 

install_path/FileNet/WebClient/

to:

JBOSS_home/server/server_name/deploy/

ii. Append the extension .war to the WorkplaceXT folder:

JBOSS_home/server/server_name/deploy/WorkplaceXT.war

iii. (optional) For a custom name for the context root (and the application), rename the 
WorkplaceXT.war folder to custom_name.war, where custom_name is the name you 
choose for your application.

• (For WAR file deployment only) 

i. On the JBoss server, copy the web_client.war (or custom_name.war) file from:

install_path/FileNet/WebClient/deploy/

to:

JBOSS_home/server/server_name/deploy/

• (For EAR file deployment only) 

i. On the JBoss server, copy the web_client.ear file from: 

install_path/FileNet/WebClient/deploy/

to:

JBOSS_home/server/server_name/deploy/

3. Start or restart the JBoss application server.

4. Verify that the application deployed successfully.

Verify that the server.log file located in JBOSS_home/server/server_name/log lists 
deployment of the WAR or EAR file you used.

5. (Windows only) From the Windows Services Console, restart the Process Workplace XT 
Services Manager service. 
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6. Restart Process Task Manager and Component Manager. 

7. Exit the Process Task Manager application.

NOTE  Each new version of Workplace XT can add new actions or modify existing actions. When 
you have completed the upgrade and deployment steps, review the new and modified actions in 
your upgraded Workplace XT environment and apply whatever access roles are appropriate for 
your site. For details, see the IBM FileNet Workplace XT help topic User Help > Actions, preferences, 
and tools > Site preferences > Actions preferences.
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Task 6: Upgrade multiple instances of IBM FileNet 
Workplace XT
If you are upgrading Workplace XT in an environment where you have multiple instances of 
Workplace XT on a single application server, use the procedure in “Upgrade IBM FileNet Workplace 
XT” on page 103 with the following modifications:

• In Step 5 on page 103 (Back up, undeploy, and remove the Workplace XT web application from 
the J2EE application server): 

– Make backup copies of all deployed instances of Workplace XT.

– Uninstall all deployed instances of Workplace XT.

– Delete the temp directory for all instances of Workplace XT.

• In Step 6 on page 104 (Copy existing configuration files), you must copy the web.xml files for 
each deployed instance of Workplace XT, and give the copy a descriptive name (such as 
web.xml.2).

• After Step 7 on page 104 (Start the upgrade process), do the following:

a. Back up the existing configuration files in install_path/FileNet/Config/WebClient2 
(and all other instances).

b. For each instance, copy the updated configuration files in install_path/FileNet/
Config/WebClient to install_path/FileNet/Config/WebClient2 (and so forth) and 
manually edit in any custom changes from the old configuration files to the new updated 
files.

• When you redeploy Workplace XT, using the Deploy IBM FileNet Workplace XT topic 
appropriate for your application server type, you must repackage the WAR/EAR files for the 
additional instances of Workplace XT using the modified web.xml files mentioned above. For 
information, see “Deploy multiple IBM FileNet Workplace XT instances” on page 98.
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Remove IBM FileNet Workplace XT software

To remove IBM FileNet Workplace XT software

Use the topics below to remove IBM FileNet Workplace XT according to your application server 
type.

• “Remove IBM FileNet Workplace XT (WebSphere)” on page 125.

• “Remove IBM FileNet Workplace XT (WebLogic)” on page 127.

• “Remove IBM FileNet Workplace XT (JBoss)” on page 129
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Remove IBM FileNet Workplace XT (WebSphere)
This task includes IBM FileNet Workplace XT removal instructions for WebSphere on UNIX and 
Windows platforms.

NOTE  If you are using an add-on product with Workplace XT, you must uninstall that product 
before you uninstall Workplace XT. You may also be uninstalling the Content Engine client as part 
of the Workplace XT uninstall procedure. Collect any additional installation and upgrade 
documentation, including the Content Engine readme, before beginning this procedure.

To remove the IBM FileNet Workplace XT software

1. Log in to the server.

UNIX

Log in as a user with write access to the /bin directory and the directory where IBM FileNet 
Workplace XT is installed.

Windows

Log in as a user with Administrative rights.

2. Log in to the WebSphere Administrative Console.

3. Undeploy the IBM FileNet Workplace XT application.

a. Stop the IBM FileNet Workplace XT web app in the Administrative Console.

b. Uninstall the IBM FileNet Workplace XT application from Enterprise Applications. 

c. Save changes to the master configuration.

4. Shut down WebSphere.

5. If you're running the Component Manager, stop the instances and exit the Process Task 
Manager.

6. Uninstall any IBM FileNet add on products, such as IBM FileNet eForms, that you are using with 
Workplace XT. 

For details, see the installation and upgrade documentation for the add-on products. To 
download these and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14

7. Navigate to the /_WCuninst folder under the IBM FileNet Workplace XT installation location. The 
default location is:

UNIX

/opt/FileNet/WebClient/_WCuninst

Windows

C:\Program Files\FileNet\WebClient\_WCuninst

8. Run the Workplace XT uninstall program:
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UNIX 

uninstaller.bin

Windows

uninstaller.exe

Reboot or log out as prompted during the uninstall.

NOTE  For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove IBM FileNet Workplace XT.

On Windows, when you click Next on the IBM FileNet Workplace XT Uninstaller Welcome screen, the 
second screen asks you to wait while Windows Task Manager service shuts down before continuing 
the uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the 
uninstall wizard from the next screen.

CAUTION  Do not uninstall the Content Engine client in Step 9 if Workplace XT is collocated with 
some other application, such as Application Engine, that requires a Content Engine client 
installation.

9. Uninstall the Content Engine client. See the readme file associated with the version of your 
Content Engine client. To download this and other IBM FileNet product documentation from the 
IBM web site, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 14.

10. Delete the temporary working directory for Workplace XT on the application server:

WAS_HOME/temp/node_name/application_server_name/WorkplaceXT

11. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Delete 
the install_path/FileNet directory. 

12. (If IBM FileNet Workplace XT is not the only FileNet P8 application installed on the server) 
Delete the WebClient directories in the following locations:

install_path/FileNet/WebClient

install_path/FileNet/Config/WebClient

13. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If IBM FileNet Workplace XT is the only FileNet P8 application running on the server you must 
remove the P8TASKMAN_HOME system environment variable to complete the application 
removal.

WARNING Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.

14. (UNIX only) Delete the following Install Shield directory, which can cause errors when you re-
install IBM FileNet Workplace XT:

/InstallShield/Universal/FileNet/WebClient

For AIX, the path is as follows:

/usr/lib/objrepos/InstallShield/Universal/FileNet/WebClient
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Remove IBM FileNet Workplace XT (WebLogic)
This task includes IBM FileNet Workplace XT removal instructions for WebLogic on UNIX and 
Windows platforms.

NOTE  If you are using an add-on product with Workplace XT, you must uninstall that product 
before you uninstall Workplace XT. You may also be uninstalling the Content Engine client as part 
of the Workplace XT uninstall procedure. Collect any additional installation and upgrade 
documentation, including the Content Engine readme, before beginning this procedure.

To remove the IBM FileNet Workplace XT software

1. Log in to the application server.

UNIX

Log in as a user with write access to the /bin directory and the directory where IBM FileNet 
Workplace XT is installed.

Windows

Log in as a user with Administrative rights.

2. Undeploy the IBM FileNet Workplace XT application.

a. Stop the IBM FileNet Workplace XT Web Application Module.

b. Delete the IBM FileNet Workplace XT Web Application Module.

3. Shut down WebLogic.

4. If you're running the Component Manager, stop the instances and exit the Process Task 
Manager.

5. Uninstall any IBM FileNet add on products, such as IBM FileNet eForms, that you are using with 
Workplace XT. 

For details, see the installation and upgrade documentation for the add-on products. To 
download these and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14

6. Navigate to the /_WCuninst folder under the IBM FileNet Workplace XT installation location. The 
default location is:

UNIX

/opt/FileNet/WebClient/_WCuninst

Windows

C:\Program Files\FileNet\WebClient\_WCuninst

7. Run the uninstall program:

UNIX

uninstaller.bin
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Windows

uninstaller.exe

Reboot or log out as prompted during the uninstall.

NOTE  For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove IBM FileNet Workplace XT.

On Windows, when you click Next on the IBM FileNet Workplace XT Uninstaller Welcome screen, the 
second screen asks you to wait while Windows Task Manager service shuts down before continuing 
the uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the 
uninstall wizard from the next screen.

CAUTION  Do not uninstall the Content Engine client in Step 8 if Workplace XT is collocated with 
some other application, such as Application Engine, that requires a Content Engine client 
installation.

8. Uninstall the Content Engine client. See the readme file associated with the version of your 
Content Engine client. To download this and other IBM FileNet product documentation from the 
IBM web site, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 14.

9. Delete the contents of the temporary working directory for Workplace XT on the application 
server:

weblogic_install_path/project_name/domains/domain_name/servers/
AdminServer/tmp/_WL_internal

10. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Delete 
the install_path/FileNet directory. 

11. (If IBM FileNet Workplace XT is not the only FileNet P8 application installed on the server) 
Delete the WebClient directories in install_path/FileNet/WebClient.

12. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If IBM FileNet Workplace XT is the only IBM FileNet P8 application running on the server you 
must remove the P8TASKMAN_HOME system environment variable to complete the 
uninstallation.

WARNING Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.

13. (UNIX only) Delete the following Install Shield directory, which can cause errors when you re-
install IBM FileNet Workplace XT:

/InstallShield/Universal/FileNet/WebClient

For AIX, the path is as follows:

/usr/lib/objrepos/InstallShield/Universal/FileNet/WebClient
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Remove IBM FileNet Workplace XT (JBoss)
This task includes Workplace XT removal instructions for JBoss on UNIX and Windows platforms.

NOTE  If you are using an add-on product with Workplace XT, you must uninstall that product 
before you uninstall Workplace XT. You may also be uninstalling the Content Engine client as part 
of the Workplace XT uninstall procedure. Collect any additional installation and upgrade 
documentation, including the Content Engine readme, before beginning this procedure.

To remove the IBM FileNet Workplace XT software

1. Log on to the application server:

UNIX

Log in as a user with write access to the /bin directory and the directory where IBM FileNet 
Workplace XT is installed.

Windows

Log in as a user with Administrative rights.

2. Shut down JBoss.

3. Remove deployment and temporary files and directories:

a. Remove the web_client.war (or custom_name.war) folder from
JBoss_HOME/server/server_name/deploy/.

b. Clear out all files and folders within the following temp directories:

JBoss_home/server/server_name/tmp/deploy
JBoss_home/server/server_name/work/jboss.web/localhost

4. If you are running the Component Manager, stop the instances and exit the Process Task 
Manager.

5. Uninstall any IBM FileNet add on products, such as IBM FileNet eForms, that you are using with 
Workplace XT. 

For details, see the installation and upgrade documentation for the add-on products. To 
download these and other IBM FileNet product documentation from the IBM web site, see 
“Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 14

6. Navigate to the _WCuninst folder under the IBM FileNet Workplace XT installation location. The 
default location is:

UNIX

/opt/FileNet/WebClient/_WCuninst

Windows

C:\Program Files\FileNet\WebClient\_WCuninst

7. Run the uninstall program:
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UNIX 

uninstaller.bin

Windows

uninstaller.exe

Reboot and log out as prompted during the uninstall.

NOTE  For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove IBM FileNet Workplace XT.

On Windows, when you click Next on the IBM FileNet Workplace XT Uninstaller Welcome screen, the 
second screen asks you to wait while Windows Task Manager service shuts down before continuing 
the uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the 
uninstall wizard from the next screen.

CAUTION  Do not uninstall the Content Engine client in Step 8 if Workplace XT is collocated with 
some other application, such as Application Engine, that requires a Content Engine client 
installation.

8. Uninstall the Content Engine client. See the readme file associated with the version of your 
Content Engine client. To download this and other IBM FileNet product documentation from the 
IBM web site, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 14.

9. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Search 
for the vpd.properties file. If it exists, delete it.

10. (UNIX and Linux) Remove the P8TASKMAN_HOME system environment variable.

If Workplace XT is the only IBM FileNet P8 application running on the server you must remove 
the P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.

11. (If IBM FileNet Workplace XT is the only FileNet P8 application installed on the server) Delete 
the install_path/FileNet directory. 

12. (If IBM FileNet Workplace XT is not the only FileNet P8 application installed on the server) 
Delete the WebClient directories in the following locations:

install_path/FileNet/WebClient

install_path/FileNet/Config/WebClient

13. (UNIX only) Delete the following Install Shield directory, which can cause errors when you re-
install IBM FileNet Workplace XT:

/InstallShield/Universal/FileNet/WebClient

For AIX, the path is as follows:

/usr/lib/objrepos/InstallShield/Universal/FileNet/WebClient
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Appendixes

This appendixes section contains the following major topics:

• “Encrypt passwords for silent installation and upgrades” on page 132

• “IBM FileNet Workplace XT port numbers” on page 133



 Encrypt passwords for silent installation and upgrades
To encrypt a password
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Encrypt passwords for silent installation and 
upgrades
Several passwords are required to silently install IBM FileNet P8 components. These passwords 
should be encrypted before you enter them in the silent installation resource files. 

To encrypt a password

1. The encryption tool is located on the installation media for Process Engine software, in the Tools 
directory. Copy the following files from the Tools directory to a local drive:

• fnencryptutils - an executable .jar file

• RunEncryptApp - a batch file

2. Run RunEncryptApp.bat to invoke the application. 

3. Enter the appropriate values for the user name and password. 

4. Reenter the password to confirm it.

5. Click Generate.

6. An encrypted password will be generated and displayed in the encrypted password field.

7. Copy and paste this password into the appropriate silent installation resource file.
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IBM FileNet Workplace XT port numbers
The table below lists the default port numbers used by IBM FileNet Workplace XT. 

IBM FileNet Workplace XT Ports

WebSphere / WebSphere SSL 9080 / 9443

WebLogic / WebLogic SSL 7001 / 7002

JBoss / JBoss SSL 8080 / 8443

Process Engine (RMI) 32771

Component Manager (Event Port)

NOTE  Ensure that this port number is open if you are using 
Component Manager. On UNIX systems, this port is closed by 
default.

32776

Web Services Reliable Messaging Client Port 32777
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Index
A
access roles, Application Engine Administrators 73
Application Integration

collocation issues 83
install 83
uninstall 86
verify installation 86

Application Integration BCS
install 91
uninstall 94

Application Integration Toolkit, collocation issues 83
application server considerations 18

B
bootstrap preferences

bootstrap.properties file location 71
configure 71
SSL configuration 72

bootstrap.properties file
location 71

C
cluster

bootstrap.properties file 71
install generic server 21

configuration
JBoss 55
WebLogic 47
WebSphere 39

connection point, configure 75
container managed 18
Content Engine

specify for Workplace XT 25

D
deploy

JBoss 67, 120
WebLogic 65, 118
WebSphere 62, 115

documentation
configure site preference settings (bootstrap) 72
Workplace XT configuration 26

F
farm or cluster deployment 27
File Tracker

install 88
uninstall 89
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FileNet P8 documentation
configure for Workplace XT help 26

I
installation

configuration and startup tasks 70
optional tasks 82
required tasks 17
setup wizard 21
silent, resource file for 132

IP address
SSL host 79

J
JBoss

configure 55
deploy Workplace XT 67, 120
remove Workplace XT software 129

M
Microsoft Office, integration install 83
multiple instances 98
multi-server configuration 98

P
ports 133

R
remove

Workplace XT software (JBoss) 129
Workplace XT software (WebLogic) 127
Workplace XT software (WebSphere) 125

S
security

info preference, SSL 72
SSL, set up 77

set
bootstrap properties 71
documentation server URL 72
SSO proxy parameters for 47

Site preference settings
documentation URL 72
name and location 72

specify Application Engine administrators access role 72
SSL

Java applets 80
security info preference 72
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set up 77
SSO

edit configuration files (WebLogic) 47
edit configuration files (WebSphere) 39

U
upgrade 103
User Token

configure 72
Crypto key file path 29

UTCryptoKeyfile.properties 29

W
web farm

bootstrap.properties file 71
install generic server 21

web.xml
edit for SSO (WebLogic) 47
edit for SSO (WebSphere) 39

WebLogic
configure 47
deploy Workplace XT 65, 118
remove Workplace XT software 127

WebSphere
configure 39
deploy Workplace XT 62, 115
remove Workplace XT software 125

Workplace
File Tracker install 88
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This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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BM Corporation
46A/G4
55 Bailey Avenue
an Jose, CA 95141-1003
.S.A.

uch information may be available, subject to appropriate terms and conditions, including in some cases,
ayment of a fee.

he licensed program described in this document and all licensed material available for it are provided
y IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
ny equivalent agreement between us.

ny performance data contained herein was determined in a controlled environment. Therefore, the
esults obtained in other operating environments may vary significantly. Some measurements may have
een made on development-level systems and there is no guarantee that these measurements will be the
ame on generally available systems. Furthermore, some measurements may have been estimated through
xtrapolation. Actual results may vary. Users of this document should verify the applicable data for their
pecific environment.

nformation concerning non-IBM products was obtained from the suppliers of those products, their
ublished announcements or other publicly available sources. IBM has not tested those products and
annot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
roducts. Questions on the capabilities of non-IBM products should be addressed to the suppliers of

hose products.

ll statements regarding IBM’s future direction or intent are subject to change or withdrawal without
otice, and represent goals and objectives only.

his information contains examples of data and reports used in daily business operations. To illustrate
hem as completely as possible, the examples include the names of individuals, companies, brands, and
roducts. All of these names are fictitious and any similarity to the names and addresses used by an
ctual business enterprise is entirely coincidental.

OPYRIGHT LICENSE:

his information contains sample application programs in source language, which illustrate programming
echniques on various operating platforms. You may copy, modify, and distribute these sample programs

any form without payment to IBM, for the purposes of developing, using, marketing or distributing
pplication programs conforming to the application programming interface for the operating platform for
hich the sample programs are written. These examples have not been thoroughly tested under all

onditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
rograms.
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Trademarks
Trademarks

 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at ″Copyright and trademark information″ at
www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.
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